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Copyright and Trademarks

Copyright and Trademarks

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any
means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko
Epson Corporation. No patent liability is assumed with respect to the use of the information contained herein. Neither
is any liability assumed for damages resulting from the use of the information herein. The information contained
herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for
damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of accident, misuse, or abuse of
this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to
strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation and its affiliates shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson Approved
Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that
occurs from the use of any interface cables other than those designated as Epson Approved Products by Seiko Epson
Corporation.

EPSON® is a registered trademark, and EPSON EXCEED YOUR VISION or EXCEED YOUR VISION is a trademark
of Seiko Epson Corporation.

PRINT Image Matching™ and the PRINT Image Matching logo are trademarks of Seiko Epson Corporation.
Copyright © 2001 Seiko Epson Corporation. All rights reserved.

Intel® is a registered trademark of Intel Corporation.

PowerPC® is a registered trademark of International Business Machines Corporation.

Epson Scan software is based in part on the work of the Independent JPEG Group.

libtiff

Copyright © 1988-1997 Sam Leffler
Copyright © 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is
hereby granted without fee, provided that (i) the above copyright notices and this permission notice
appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and
Silicon Graphics may not be used in any advertising or publicity relating to the software without the
specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
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IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT
ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Microsoft®, Windows®, and Windows Vista® are registered trademarks of Microsoft Corporation.

Apple, Macintosh, Mac OS, and OS X are trademarks of Apple Inc., registered in the U.S. and other countries.

AirPrint is a trademark of Apple Inc.

Google Cloud Print™ is a registered trademark of Google Inc.

Adobe, Adobe Reader, Acrobat, and Photoshop are trademarks of Adobe systems Incorporated, which may be
registered in certain jurisdictions.

SDXC Logo is a trademark of SD-3C, LLC.

Memory Stick Duo, Memory Stick PRO Duo, Memory Stick PRO-HG Duo, Memory Stick Micro, and MagicGate
Memory Stick Duo are trademarks of Sony Corporation.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their
respective owners. Epson disclaims any and all rights in those marks.

Copyright © 2013 Seiko Epson Corporation. All rights reserved.
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Introduction

Where to Find Information

The latest version of the following manuals are available on the Epson support website.
http://www.epson.eu/Support (Europe)
http://support.epson.net/ (other than Europe)

❏ Start Here (paper):

Provides you with information on setting up the product and installing the software.

❏ User’s Guide (PDF):

Provides you with detailed operating, safety, and troubleshooting instructions. See this guide when using this
product with a computer.
To view the PDF manual, you need Adobe Acrobat Reader 5.0 or later, or Adobe Reader.

❏ Network Guide (PDF):

Provides network administrators with information on both the printer driver and network settings.

Caution, Important and Note

Caution, Important, and Note in this manual are indicated as below and have the following meaning.

!Caution
must be followed carefully to avoid bodily injury.

c Important
must be observed to avoid damage to your equipment.

Note
contain useful tips and restrictions on product operation.

Operating System Versions

In this manual, the following abbreviations are used.

❏ Windows 8 refers to Windows 8 and Windows 8 Pro.

❏ Windows 7 refers to Windows 7 Home Basic, Windows 7 Home Premium, Windows 7 Professional, and
Windows 7 Ultimate.

     User’s Guide

Introduction

7

http://www.epson.eu/Support
http://support.epson.net/


❏ Windows Vista refers to Windows Vista Home Basic Edition, Windows Vista Home Premium Edition, Windows
Vista Business Edition, Windows Vista Enterprise Edition, and Windows Vista Ultimate Edition.

❏ Windows XP refers to Windows XP Home Edition, Windows XP Professional x64 Edition, and Windows XP
Professional.

❏ Mac OS X refers to Mac OS X 10.5.8, 10.6.x, 10.7.x, 10.8.x.

Using Epson Connect Service

Using Epson Connect and other companies’ services, you can easily print directly from your smartphone, tablet PC or
laptop, anytime and practically anywhere even across the globe! The services available vary by product. (& “Available
Features” on page 13)

For more information about the printing and other services, visit the following URL:
https://www.epsonconnect.com/ (Epson Connect portal site)
http://www.epsonconnect.eu (Europe only)

Note:
You can make network service settings using a Web browser on your computer, smartphone, tablet PC, or laptop that is
connected to the same network as the product. 
& “Making Network Service Settings” on page 104
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Important Instructions

Safety Instructions

Read and follow these instructions to ensure safe use of this product. Make sure you keep this guide for future
reference. Also, be sure to follow all warnings and instructions marked on the product.

❏ Use only the power cord supplied with the product and do not use the cord with any other equipment. Use of other
cords with this product or the use of the supplied power cord with other equipment may result in fire or electric
shock.

❏ Be sure your AC power cord meets the relevant local safety standard.

❏ Never disassemble, modify, or attempt to repair the power cord, plug, printer unit, scanner unit, or options by
yourself, except as specifically explained in the product’s guides.

❏ Unplug the product and refer servicing to qualified service personnel under the following conditions:
The power cord or plug is damaged; liquid has entered the product; the product has been dropped or the casing
damaged; the product does not operate normally or exhibits a distinct change in performance. Do not adjust
controls that are not covered by the operating instructions.

❏ Place the product near a wall outlet where the plug can be easily unplugged.

❏ Do not place or store the product outdoors, near excessive dirt or dust, water, heat sources, or in locations subject
to shocks, vibrations, high temperature or humidity.

❏ Take care not to spill liquid on the product and not to handle the product with wet hands.

❏ Keep this product at least 22 cm away from cardiac pacemakers. Radio waves from this product may adversely
affect the operation of cardiac pacemakers.

❏ If the LCD screen is damaged, contact your dealer. If the liquid crystal solution gets on your hands, wash them
thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with
water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately. Some
products are not equipped with the LCD screen.

Note:
The following provides safety instructions for ink cartridges.
& “Replacing Ink Cartridges” on page 80

Product Advisories and Warnings

Read and follow these instructions to avoid damaging the product or your property. Make sure you keep this guide for
future reference.

Setting up/using the product

❏ Do not block or cover the vents and openings in the product.
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❏ Use only the type of power source indicated on the product’s label.

❏ Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.

❏ Avoid electrical outlets controlled by wall switches or automatic timers.

❏ Keep the entire computer system away from potential sources of electromagnetic interference, such as
loudspeakers or the base units of cordless telephones.

❏ The power-supply cords should be placed to avoid abrasions, cuts, fraying, crimping, and kinking. Do not place
objects on top of the power-supply cords and do not allow the power-supply cords to be stepped on or run over. Be
particularly careful to keep all the power-supply cords straight at the ends and the points where they enter and
leave the transformer.

❏ If you use an extension cord with the product, make sure that the total ampere rating of the devices plugged into
the extension cord does not exceed the cord’s ampere rating. Also, make sure that the total ampere rating of all
devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.

❏ If you plan to use the product in Germany, the building installation must be protected by a 10 or 16 amp circuit
breaker to provide adequate short-circuit protection and over-current protection for the product.

❏ When connecting the product to a computer or other device with a cable, ensure the correct orientation of the
connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation may
damage both devices connected by the cable.

❏ Place the product on a flat, stable surface that extends beyond the base of the product in all directions. If you place
the product by the wall, leave more than 10 cm between the back of the product and the wall. The product will not
operate properly if it is tilted at an angle.

❏ When storing or transporting the product, avoid tilting it, placing it vertically, or turning it upside down;
otherwise ink may leak.

❏ Allow spaces behind the product for the cables, and space above the product so that you can fully raise the
document cover.

❏ Leave enough space in front of the product for the paper to be fully ejected.

❏ Avoid places subject to rapid changes in temperature and humidity. Also, keep the product away from direct
sunlight, strong light, or heat sources.

❏ Do not insert objects through the slots in the product.

❏ Do not put your hand inside the product or touch the ink cartridges during printing.

❏ Do not touch the white flat cable inside the product.

❏ Do not use aerosol products that contain flammable gases inside or around the product. Doing so may cause
fire.

❏ Do not move the ink cartridge holder by hand; otherwise, you may damage the product.

❏ Always turn the product off using the P button. Do not unplug the product or turn off the power at the outlet until
the LCD screen has turned off completely or the P light stops flashing.
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❏ Before transporting the product, make sure that the print head is in the home (far right) position and the ink
cartridges are in place.

❏ Be careful not to trap your fingers when closing the scanner unit.

❏ If you are not going to use the product for a long period, be sure to unplug the power cord from the electrical
outlet.

❏ Do not press too hard on the scanner glass when placing the originals.

❏ During the life of your product it may be necessary to replace the waste ink pad when it has become full. Whether
and how often this is required will vary according to the number of pages you print, the type of material that you
print and the number of cleaning cycles that the product performs. Epson Status Monitor, your LCD, or lights on
the control panel will advise you when this part needs replacing. The need for replacement of the pad does not
mean that your product has ceased to operate in accordance with its specifications. The replacement of this part is
a routine product servicing activity within the product’s specification and is not a problem which requires repair.
The Epson warranty does not therefore cover the cost of this replacement. If your product needs the pad replacing
this can be performed for you by any authorised Epson service provider. It is not a user-serviceable part.

Using the product with a wireless connection

❏ Do not use this product inside medical facilities or near medical equipment. Radio waves from this product may
adversely affect the operation of electrical medical equipment.

❏ Do not use this product near automatically controlled devices such as automatic doors or fire alarms. Radio waves
from this product may adversely affect these devices, and could lead to accidents due to malfunction.

Using memory cards

Note:
The availability of this feature varies by product.

❏ Do not remove a memory card or turn off the product while the memory card light is flashing.

❏ The methods for using memory cards vary according to card type. Be sure to refer to the documentation packaged
with your memory card for details.

❏ Use only memory cards compatible with the product.

& “Memory card” on page 146

Using the LCD screen/touchpad

Note:
The availability of this feature varies by product.

❏ The LCD screen may contain a few small bright or dark spots, and because of its features it may have an uneven
brightness. These are normal and do not indicate that it is damaged in any way.
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❏ Only use a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.

❏ The exterior cover of the LCD screen could break if it receives a heavy impact. Contact your dealer if the panel
surface chips or cracks, and do not touch or attempt to remove the broken pieces.

❏ For XP-410 Series
The touchpad is a capacitive touch panel, which responds only when touched directly with a finger. The panel may
not respond when touched with wet hands, gloved hands, or touched through a protective sheet or sticker.

❏  Press the touch panel and touchpad gently with your finger. Do not press force or operate with your nails.

❏ Do not operate by a sharp edge thing such as a ball point pen, sharp pencil, stylus pen and so on.

❏ Condensation inside the panel due to abrupt changes in temperature or humidity may cause performance to
deteriorate.

Handling ink cartridges

We will provide ink-related safety instructions and product advice/warnings in the linked section (before “Replacing
Ink Cartridges” section).

& “Replacing Ink Cartridges” on page 80

Restrictions on Copying

Observe the following restrictions in order to ensure the responsible and legal use of the product.

Copying of the following items is prohibited by law:

❏ Bank bills, coins, government-issued marketable securities, government bond securities, and municipal securities

❏ Unused postage stamps, pre-stamped postcards, and other official postal items bearing valid postage

❏ Government-issued revenue stamps, and securities issued according to legal procedure

Exercise caution when copying the following items:

❏ Private marketable securities (stock certificates, negotiable notes, checks, etc.), monthly passes, concession
tickets, etc.

❏ Passports, driver’s licenses, warrants of fitness, road passes, food stamps, tickets, etc.

Note:
Copying these items may also be prohibited by law.

Responsible use of copyrighted materials:

❏ Products can be misused by improperly copying copyrighted materials. Unless acting on the advice of a
knowledgeable attorney, be responsible and respectful by obtaining the permission of the copyright holder before
copying published material.
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Getting to Know Your Product

Available Features

Check what is available for your product.

Features XP-410 Series XP-310 Series XP-210 Series

Print from a PC ✓ ✓ ✓

from a memory card ✓ ✓ -

Copy Standard copy ✓ ✓ ✓

Borderless copy ✓ ✓ -

Scan from a PC ✓ ✓ ✓

from product to a PC ✓ ✓ ✓

from product to a
memory card

✓ - -

Epson Connect
services

iPrint ✓ ✓ ✓

Email Print ✓ ✓ ✓ *

Remote Print Driver ✓ ✓ ✓ *

Scan to Cloud ✓ - -

Other companies’
services

AirPrint ✓ ✓ ✓ *

Google Cloud Print ✓ ✓ ✓ *

* XP-212/XP-213/XP-216 do not support these functions.

Note:
The illustrations in this manual are from a similar product model. Although they may differ from your actual product, the
method of operation is the same.
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Product Parts

a. Paper support

b. Output tray

c. Stopper

d. Feeder guard

e. Edge guide

f. Sheet feeder
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a. Document cover

b. Scanner glass

c. Control panel

d. Release lever (rear of the control panel)

e. Memory card slot

f. Memory card light
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a. Scanner Unit

b. Ink cartridge holder

c. Print head (under the ink cartridge holder)

d. Scanner unit support

a. USB connector for connecting to a computer

b. AC inlet
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Guide to the Control Panel

Note:
Although the control panel design and menu and option names and other items in the LCD display may slightly differ from
the actual product, the method of operation is the same.

XP-410 Series

XP-310 Series

Buttons/Lights/Icons Function

a Turns the product on and off. The button light stays on when the product is on. Flashes when
the product is receiving data, printing/copying/scanning, replacing an ink cartridge, charging
ink, or cleaning the print head.

b Returns to the top menu.

c - LCD screen (2.5-inch)

d - LCD screen (1.44-inch)

e Cancels/returns to the previous menu.

f l, u, r, d, OK Press l, u, r, d to select menus. Press OK to confirm the setting you have selected and go to
next screen.

g +, - Sets the number of copies and prints.

h Starts the operation you selected.

i Stops the ongoing operation or initialize the current settings.
For 1.44-inch display model, this also allows you to return to the previous screen.

- An icon displayed at the upper left on the LCD screen. Shows the network status.

& “Network status icon:” on page 18
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Buttons/Lights/Icons Function

- An icon displayed only on the 2.5-inch LCD screen. Indicates the status as follows.

Green: Epson Connect services are online.

Orange: Epson Connect services are suspended.

Gray: Epson Connect services are unavailable.

& “Using Epson Connect Service” on page 8

Network status icon:

XP-410 Series

Icons Status

Wi-Fi network error/searching

Connected to a Wi-Fi network (signal strength: Fair)

Connected to a Wi-Fi network (signal strength: Good)

Connected to a Wi-Fi network (signal strength: Excellent)

Indicates Ad Hoc Connection is on

Displays the printer is connected via Simple AP mode

Displays the printer is connected via Wi-Fi Direct mode

Processing a Wi-Fi connection

XP-310 Series

Icons Status

Wi-Fi network error/searching

Connected to a Wi-Fi network (signal strength: Fair)

Connected to a Wi-Fi network (signal strength: Good)

Connected to a Wi-Fi network (signal strength: Excellent)

Indicates Ad Hoc Connection is on

Displays the printer is connected via Simple AP mode

Displays the printer is connected via Wi-Fi Direct mode
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Icons Status

Processing a Wi-Fi connection

XP-210 Series

Buttons/Lights Function

a The green light (left) stays on while the product is connected to a Wi-Fi network. If only the
orange light (right) is flashing, a network error has occurred. & “Error Indications on the
Control Panel (XP-210 Series)” on page 115

b P *1 *4 Turns the product on or off. The button light stays on when the product is on. Flashes when the
product is receiving data, printing/copying/scanning, replacing an ink cartridge, charging
ink, or cleaning the print head.

c Wi-Fi*5 Press to clear a network error. Press for 3 seconds to start making AOSS/WPS push button
settings.

d *1*5 Prints a network status sheet.

e *2 *3 *6 Starts monochrome copy. Press for 3 seconds to copy in draft mode.

f *2 *3 *6 Starts color copy. Press for 3 seconds to copy in draft mode.

g y *2*4 Cancels a print job, copy job, or scan job and stops printing or scanning.

Hold this button down for 3 seconds (until the power light flashes) to run print head cleaning.

When the ink light turns on, press this button to start the ink cartridge replacement process.
When you need to replace an ink cartridge before it is expended (when the ink light is off), hold
this button down for 6 seconds (until the print head moves) to start the replacement process.

& “Replacing an Ink Cartridge” on page 89

h b &  “Error Indications on the Control Panel (XP-210 Series)” on page 115

i & “Error Indications on the Control Panel (XP-210 Series)” on page 115

*1 While pressing , turn on the product to return the network settings to their defaults.

*2 Press x r or r x and y at the same time to make 20 copies.

*3 You can scan your original and save it in PDF format on your computer by pressing the two start buttons simultaneously.

*4 While pressing y, turn on the product to print the nozzle check. & “Checking the Print Head Nozzles” on page 97

*5 Press the Wi-Fi and  buttons simultaneously to start WPS PIN code auto connect setting.

*6 For users in Belgium, draft mode is not available.
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Paper and Media Handling

Introduction to Using, Loading, and Storing Media

You can achieve good results with most types of plain paper. However, coated papers provide superior prints because
they absorb less ink.

Epson provides special papers that are formulated for the ink used in Epson ink jet products, and recommends these
papers to ensure high-quality results.

When loading special paper distributed by Epson, read the instruction sheets packed with the paper first and keep the
following points in mind.

Note:
❏ Load the paper into the rear paper feed printable side up. The printable side is usually whiter or glossier. See the

instruction sheets packed with the paper for more information. Some types of paper have cut corners to help identify the
correct loading direction.

❏ If the paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing on curled paper may
cause ink to smear on your prints. Do not use the paper that is folded, wavy or torn.

Storing paper

Return unused paper to the original package as soon as you finish printing. When handling special media, Epson
recommends storing your prints in a resealable plastic bag. Keep unused paper and prints away from high
temperature, humidity, and direct sunlight.

Selecting Paper

The table below lists supported papers. Loading capacity and borderless print availability varies by paper as shown.
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Media Type Size

Loading capacity (sheets)

Borderless
printing

XP-310
Series/
XP-410 Series

XP-210 Series

Plain paper*1 Letter*2 up to 11mm up to 6mm -

A4*2 up to 11mm up to 6mm -

B5*2 up to 11mm up to 6mm -

A5*2 up to 11mm up to 6mm -

A6*2 up to 11mm up to 6mm -

Legal 1 1 -

User Defined 1 1 -

Envelope #10 10 5 -

DL 10 5 -

C6 10 5 -

Epson Bright White Ink Jet Paper A4*2 80 40 -

Epson Photo Quality Ink Jet Paper A4 80 40 -

Epson Matte Paper - Heavyweight A4 20 20 ✓

Epson Photo Paper A4 20 10 ✓

10 × 15 cm (4 × 6 in.) 20 10 ✓

13 × 18 cm (5 × 7 in.) 20 10 ✓

Epson Premium Glossy Photo
Paper

A4 20 10 ✓

10 × 15 cm (4 × 6 in.) 20 10 ✓

13 × 18 cm (5 × 7 in.) 20 10 ✓

16:9 wide size (102 × 181mm) 20 10 ✓

Epson Premium Semigloss Photo
Paper

A4 20 10 ✓

10 × 15 cm (4 × 6 in.) 20 10 ✓

Epson Ultra Glossy Photo Paper A4 20 10 ✓

10 × 15 cm (4 × 6 in.) 20 10 ✓

13 × 18 cm (5 × 7 in.) 20 10 ✓
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Media Type Size

Loading capacity (sheets)

Borderless
printing

XP-310
Series/
XP-410 Series

XP-210 Series

Epson Glossy Photo Paper A4 20 10 ✓

10 × 15 cm (4 × 6 in.) 20 10 ✓

13 × 18 cm (5 × 7 in.) 20 10 ✓

*1 Paper with a weight of 64 g/m2 (17 lb) to 90 g/m2 (24 lb).

*2 The loading capacity for manual 2-sided printing is 30 sheets for XP-310 Series/XP-410 Series and 15 sheets for XP-210 Series.

Note:
The availability of special media varies by location. For the latest information on media available in your area, contact
Epson support.
& “Technical Support Web Site” on page 151

Paper type settings on the LCD screen

The product automatically adjusts itself for the type of paper you select in your print settings. That is why the paper
type setting is so important. It tells your product what kind of paper you are using and adjusts the ink coverage
accordingly. The table below lists the settings you should choose for your paper.

For this paper LCD paper type

Plain paper Plain Paper

Epson Bright White Ink Jet Paper

Epson Ultra Glossy Photo Paper Photo Paper

Epson Premium Glossy Photo Paper

Epson Premium Semigloss Photo Paper

Epson Glossy Photo Paper

Epson Photo Paper

Epson Matte Paper - Heavyweight Matte

Epson Photo Quality Ink Jet Paper

Paper type settings from the printer driver

The product automatically adjusts itself for the type of paper you select in your print settings. That is why the paper
type setting is so important. It tells your product what kind of paper you are using and adjusts the ink coverage
accordingly. The table below lists the settings you should choose for your paper.
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For this paper Printer driver paper type

Plain paper* plain papers

Epson Bright White Ink Jet Paper*

Epson Ultra Glossy Photo Paper* Epson Ultra Glossy

Epson Premium Glossy Photo Paper* Epson Premium Glossy

Epson Premium Semigloss Photo Paper* Epson Premium Semigloss

Epson Glossy Photo Paper* Epson Glossy

Epson Photo Paper* Epson Photo

Epson Matte Paper – Heavyweight* Epson Matte

Epson Photo Quality Ink Jet Paper*

Envelopes Envelope

* These paper types are compatible with Exif Print and PRINT Image Matching. For more information, refer to the documentation
that came with the Exif Print or PRINT Image Matching compatible digital camera.

Loading Paper and Envelopes

Follow these steps to load paper.

Note:
The illustrations in this section may vary depending on the product.

A Flip the feeder guard forward.
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B Slide out the paper support and the output tray and then raise the stopper.

Note:
The XP-210 Series does not have a stopper .

C Slide the edge guide to the left.

D Fan and align the edges of the paper sheets. Then load them with the printable side up, against the right side of
the sheet feeder.
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Note:
❏ The printable side is often whiter or brighter than the other side.

❏ Always load paper into the sheet feeder short edge first, even when you are printing landscape -oriented pictures.

❏ You can use paper with binding holes. Load only one sheet of paper at a time. Make sure you adjust the size of
your file to avoid printing over the binding holes.

❏ When loading envelopes, load the short edge first with the flap facing down.

❏ Do not use envelopes that are curled, folded, or glued or that have plastic windows.

❏ Flatten the envelope and the flaps before loading.

❏ Flatten the leading edge of the envelope before loading.

❏ Avoid using envelopes that are too thin, as they may curl during printing.
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E Slide the edge guide against the left edge of the paper, but not too tightly.

Note:
For plain paper, do not load paper above the H arrow mark inside the edge guide.
For Epson special media, make sure the number of sheets is less than the limit specified for the media.

& “Selecting Paper” on page 20

F Flip the feeder guard back.

To prevent foreign materials from getting into the product, make sure you flip the feeder guard back when you
have finished printing.

Inserting a Memory Card

This function is available with XP-310 Series/XP-410 Series.

You can print photos in a memory card or save a scanned data in a memory card. The following memory cards are
supported.

SD, SDHC, SDXC, Memory Stick Duo, Memory Stick PRO Duo, Memory Stick PRO-HG Duo, MagicGate Memory
Stick Duo

The following memory cards are available with an adapter.
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c Important
Make sure you attach an adapter before inserting the card into the slot, otherwise the card may get stuck.

❏ miniSD, microSD, miniSDHC, microSDHC, microSDXC

❏ Memory Stick Micro

A Insert one card at a time.

B Check the light stays on.

 = on,  = flashing
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c Important
❏ Do not try to force the card all the way into the slot. It should not be fully inserted.

❏ Do not remove the memory card while the light is flashing. The data in the memory card may be lost.

Placing Originals

A Open the document cover and place your original face-down on the scanner glass.

B Slide the original to the corner.

Note:
See the following sections if any problems occur with the scanning area or the scanning direction when using EPSON
Scan.

& “The edges of your original are not scanned” on page 140 
& “Multiple documents are scanned into a single file” on page 140

C Close the cover gently.
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Copying

Copying Documents

Basic copying for XP-310 Series/XP-410 Series

Follow the steps below to copy documents.

Note for XP-410 Series:
To copy photos, select More Functions from the Home menu, and select Copy/Restore Photos, then follow the on-screen
instructions.You can copy one photo or multiple photos of different sizes at the same time, as long as they are larger than 30 x
40 mm.

A Load paper.
& “Loading Paper and Envelopes” on page 23

B Place your original(s) on the scanner glass.
& “Placing Originals” on page 28

C Enter the Copy mode from the Home menu.

D Set the number of copies using the + or - button (use u or d for XP-310 Series).

E Select Color or B&W.

F Press OK to display the copy setting menus. For XP-310 Series, press OK and then press d.

G Select the appropriate copy settings such as layout, paper size, paper type, and copy quality. Use u or d to select
a setting item and use l or r to change the setting. For XP-310 Series, press OK to save the changes.

H Press x to start copying.

Basic copying for XP-210 Series

Follow the steps below to copy documents.

A Load paper.
& “Loading Paper and Envelopes” on page 23

B Place your original(s) on the scanner glass.
& “Placing Originals” on page 28
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C  Press x r or r x to start copying.

Note:
❏ Press x r or r x for 3 seconds to copy in draft mode. For users in Belgium, draft mode is not available.

❏ Press x r or r x and y at the same time to make 20 copies.

Copy Mode Menu List

Refer to the section below for the Copy mode menu list.
& “Copy Mode” on page 73
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Printing

Basic Operation from the Control Panel (XP-310 Series/
XP-410 Series only)

Printing photos from a memory card

Follow the steps below to print photos directly from a memory card.

Note for XP-410 Series:
You can print photos in various layouts. Select More Functions from the Home menu, and select Photo Layout Sheet, then
follow the on-screen instructions.

A Load photo paper.
& “Loading Paper and Envelopes” on page 23

B Insert a memory card.
& “Inserting a Memory Card” on page 26

C Enter Print Photos mode from the Home menu.

D Use l or r to select a photo and set the number of copies using the + or - button (use u or d for XP-310 Series).
Repeat this step for all the photos you want to print.

Note for XP-410 Series:
❏ If you have more than 999 images on your memory card, images are automatically divided into groups and the

group selection screen is displayed. Select the group that contains the image you want to print. Images are sorted
by the date they were taken.

❏ To select another group, select Print Photos on the Home menu. Then press d and select Select Group.

E Display the print setting menus. For XP-410 Series, press d and select Print Settings. For XP-310 Series, press
OK and then press d.

Note for XP-410 Series:
You can crop and enlarge your photo. Select Crop/Zoom, and then make the settings.

F Select the appropriate print settings such as paper size and paper type. Use u or d to select a setting item and use
l or r to change the setting. For XP-310 Series, press OK to save the changes.

G Press x to start printing.
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Print photos mode menu list

Refer to the section below for the Print Photos mode menu list.
& “Print Photo Mode” on page 74

Printing using the More Functions / Personal Stationery menus

More Functions and Personal Stationery provide you with many special menus that make printing easy and fun!
Select More Functions or Personal Stationery from the Home menu, and then see the explanations below to select the
menu you want.

Menu Function

Copy/Restore Photos
(XP-410 Series only)

You can make faithful copies of your originals.
If your original photo is faded, you can restore
color to bring it back to life. You can copy one
photo or multiple photos of different sizes at
the same time, as long as they are larger than
30 × 40 mm.

Photo Layout Sheet
(XP-410 Series only)

You can print photos stored on a memory card
in various layouts. Follow the on-screen
instructions to print.

Lined Papers You can print lined paper, graph paper, and
music paper. Follow the on-screen
instructions to print.

Writing Papers You can print your own lined paper with or
without a photo set as the background. Follow
the on-screen instructions to print.
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Menu Function

Calendar You can print monthly or weekly calendars. For
monthly calendars, you can specify the year
and month. Follow the on-screen instructions
to print.

Message card
(XP-410 Series only)

You can create your own message cards with
or without a photo or a pre-designed image set
as the decoration.

& “Printing message cards (XP-410 Series
only)” on page 33

Origami Envelope
(XP-410 Series only)

You can create original envelopes with or
without pre-designed images set as the
background or as decoration. Two types of
envelope are available. After printing, fold the
paper following the instruction sheet that can
be printed from the Origami Envelope
Instruction menu.

& “Printing origami envelopes (XP-410 Series
only)” on page 34

Origami Envelope
Instruction
(XP-410 Series only)
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You can print an instruction sheet that shows
you how to fold the paper you printed using
the Origami Envelope function into an
envelope.

& “Printing origami envelopes (XP-410 Series
only)” on page 34

Printing message cards (XP-410 Series only)

You can create original message cards with or without a photo or pre-designed symbol or pattern as the decoration.

Follow the steps below to make message cards.

A Insert a memory card if you want to use a photo as the decoration for the message card.

& “Inserting a Memory Card” on page 26

B Select More Functions.

C Select Personal Stationery.
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D Select Message Card.

E Select the paper type.

F Select an image source.

You can use a pre-designed icon, symbol, or your own photo as the decoration for the message card.

G Select an icon or a photo.

H Select the image position.

I Select the line type.

J Select the line color.

K Select the print layout.

L Load A4 size paper to print a message card.

& “Loading Paper and Envelopes” on page 23

M Set the number of copies.

N Press x to start printing.

Printing origami envelopes (XP-410 Series only)

You can create original envelopes with or without pre-designed symbols or patterns as the background or as
decoration. Two types of envelope are available. After printing, fold the paper following the instruction sheet that can
be printed from the Origami Envelope Instruction menu.

A Select More Functions.

B Select Personal Stationery.

C Select Origami.

D Select Origami Envelope.

E Select an icon.
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F Select whether or not to print fold lines on the envelope.

G Select the image position.

H Select an envelope size.

I Load A4 size paper to print envelopes.

& “Loading Paper and Envelopes” on page 23

J Set the number of copies.

K Press x to start printing the origami envelope.

L If you select Yes when a message is displayed asking whether or not you want to continue printing, go back to
step 10. If you select No, go to the next step.

M Select Origami Envelope Instruction.

N Select an envelope size.

O Load A4 size paper to print an origami envelope instruction sheet.

& “Loading Paper and Envelopes” on page 23

P Set the number of copies.

Q Press x to start printing the origami envelope instruction sheet.

R Use the origami envelope instruction sheet to make the folds for the origami envelope in the correct order.

Note:
Place the instruction sheet on top of your envelope and fold both sheets together. When finished, unfold them and remove the
instruction sheet. After that, fold the envelope only, using the creases in the paper as a guide.

More Functions / Personal Stationery mode menu list

Refer to the section below for the More Functions/Personal Stationery mode menu list.

&  “More Functions Mode” on page 76

&  “Personal Stationery Mode” on page 77
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Basic Operation from Your Computer

Printer driver and status monitor

The printer driver lets you choose from a wide variety of settings to get the best printing results. The status monitor and
the printer utilities help you check the product and keep it in top operating condition.

Note for Windows users:
❏ Your printer driver automatically finds and installs the latest version of the printer driver from Epson’s Web site. Click

the Software Update button in your printer driver’s Maintenance window, and then follow the on-screen instructions.
If the button does not appear in the Maintenance window, point at All Programs or Programs in the Windows Start
menu, and check in the EPSON folder.*
* For Windows 8:
If the button does not appear in the Maintenance window, right-click on the Start screen, or swipe from the bottom or
top edge of the Start screen and select All apps, then select Software Update from EPSON category.

❏ If you want to change the language of the driver, select the language you want to use from the Language setting in your
printer driver’s Maintenance window. Depending on the location, this function may not be available.

Accessing the printer driver for Windows

You can access the printer driver from most Windows applications, the desktop or the taskbar.

To make settings that apply only to the application you are using, access the printer driver from that application.

To make settings that apply to all of your Windows applications, access the printer driver from the desktop or the
taskbar.

Refer to the following sections to access the printer driver.

Note:
Screen shots of the printer driver windows in this User’s Guide are from Windows 7.

From Windows applications

A Click Print or Print Setup on the File menu.

B In the window that appears, click Printer, Setup, Options, Preferences, or Properties. (Depending on your
application, you may need to click one or a combination of these buttons.)

From the desktop
❏ Windows 8: 

Select Desktop, Settings charm, and Control Panel. Then select Devices and Printers from the Hardware and
Sound category. Right-click on the product, or press and hold the product and select Printing preferences.

❏ Windows 7: 
Click the start button, select Devices and Printers. Then right-click the product and select Printing
preferences.
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❏ Windows Vista: 
Click the start button, select Control Panel, and then select Printer from the Hardware and Sound category.
Then select the product and then click Select printing preferences.

❏ Windows XP: 
Click Start, Control Panel, (Printers and Other Hardware,) then Printers and Faxes. Select the product, then
click Printing Preferences on the File menu.

From the shortcut icon on the taskbar
Right-click the product icon on the taskbar, then select Printer Settings.

To add a shortcut icon to the Windows taskbar, first access the printer driver from the desktop as described above.
Next, click the Maintenance tab, the Extended Settings button, and then the Monitoring Preferences button. In the
Monitoring Preferences window, select the Register the shortcut icon to the task bar check box.

Getting information through online help
In the printer driver window, try one of the following procedures.

❏ Right-click the item, then click Help.

❏ Click the  button at the top right of the window, then click the item (for Windows XP only).

Accessing the printer driver for Mac OS X

The table below describes how to access the printer driver dialog.

Dialog Box How to Access It

Page Setup Click Page Setup on the File menu of your application.

Note:
Depending on your application, the Page Setup menu may not appear in the File menu.

Print Click Print on the File menu of your application.

Epson Printer Utility 4 For Mac OS X 10.8 or 10.7, click System Preferences on the Apple menu and then click Print &
Scan. Select your product from the Printers list box, click Options & Supplies, Utility, and then
click Open Printer Utility.

For Mac OS X 10.6, click System Preferences on the Apple menu and then click Print & Fax. Select
your product from the Printers list box, click Options & Supplies, Utility, and then click Open
Printer Utility.

For Mac OS X 10.5, click System Preferences on the Apple menu and then click Print & Fax. Select
your product from the Printers list box, click Open Print Queue and then click Utility button.
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Basic Printing

Note:
❏ The screen shots in this manual may vary depending on the model.

❏ Before you print, load paper properly.
& “Loading Paper and Envelopes” on page 23

❏ Refer to the section below for the printable area.
& “Printable area” on page 144

❏ After completing the settings, print one test copy and examine the results before printing an entire job.

Basic product settings for Windows

A Open the file you want to print.

B Access the printer settings.
& “Accessing the printer driver for Windows” on page 36

C Click the Main tab.
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D Select the appropriate Type setting.
& “Paper type settings from the printer driver” on page 22

Note:
Print quality is automatically adjusted for the selected paper type setting.

E Select Borderless if you want to print borderless photos.
& “Selecting Paper” on page 20

If you want to control the amount of the image that extends beyond the edges of the paper, click the Page Layout
tab, select Auto Expand as the Enlargement Method, and then adjust the Expansion slider.

F Select the appropriate Size setting. You can also define a custom paper size. For details, see the online help.

G Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

Note:
Select Landscape when printing on envelopes.

H Click OK to close the printer settings window.

Note:
To make changes to advanced settings, refer to the relevant section.

I Print your file.

Basic product settings for Mac OS X

Note:
Screen shots of the printer driver windows in this manual are from Mac OS X 10.7.

A Open the file you want to print.
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B Access the Print dialog box.
& “Accessing the printer driver for Mac OS X” on page 37

Note:
If the simplified dialog box is displayed, click the Show Details button (for Mac OS X 10.8 or 10.7) or the d button
(for Mac OS X 10.6 or 10.5) to extend this dialog box.

C Select the product you are using as the Printer setting.

Note:
Depending on your application, you may not be able to select some of the items in this dialog box. If so, click Page
Setup on the File menu of your application, and then make suitable settings.

D Select the appropriate Paper Size setting.

Note:
Select XXX ( Borderless) as the Paper Size if you want to print borderless photos.
& “Selecting Paper” on page 20

E Select the appropriate Orientation setting.

Note:
Select landscape orientation when printing envelopes.
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F Select Print Settings from the pop-up menu.

G Select the appropriate Media Type setting.
& “Paper type settings from the printer driver” on page 22

H Select the appropriate Expansion setting during borderless printing to control the amount of the image that
extends beyond the edges of the paper.

I Click Print to start printing.

Canceling Printing

If you need to cancel printing, follow the instructions in the appropriate section below.

Using the control panel

Press y to cancel a print job in progress.
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For Windows

Note:
You cannot cancel a print job that has been completely sent to the product. In this case, cancel the print job by the product.

Using the progress meter

When you start printing, the progress meter appears on your computer screen.

Click the Cancel button to cancel printing.

Using EPSON Status Monitor 3

A Access the EPSON Status Monitor 3. 
& “For Windows” on page 119

B Click the Print Queue button. The Windows Spooler appears.

C Right click on the job you want to cancel and then select Cancel.

For Mac OS X
Follow the steps below to cancel a print job.

Note:
If you have sent a print job from a Mac OS X 10.6 or 10.5 through the network, you may not be able to cancel printing from
the computer. Press y on the product’s control panel to cancel a print job. To solve this problem, see the online Network
Guide.

A Click your product icon in the Dock.

B In the Document Name list, select the document which is printing.
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C Click the Delete button to cancel the print job.

For Mac OS X 10.8:
Click the  button to cancel the print job.

Other Options

Printing photos the easy way

Epson Easy Photo Print lets you lay out and print digital images on various types of paper. The step-by-step
instructions in the window let you preview the printed images and get the effects you want without having to make any
difficult settings.

Using the Quick Print function, you can perform one-click printing with the settings you make.
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Starting Epson Easy Photo Print

For Windows
❏ Double-click the Epson Easy Photo Print icon on the desktop.

❏ For Windows 8: 
Select All apps, and then select Easy Photo Print from Epson Software.

For Windows 7 and Vista: 
Click the start button, point to All Programs, click Epson Software, and then click Easy Photo Print.

For Windows XP: 
Click Start, point to All Programs, point to Epson Software, then click Easy Photo Print.

For Mac OS X
Double-click the Applications folder on your Mac OS X hard drive, then double-click in turn on the Epson Software
and Easy Photo Print folders and finally double-click the Easy Photo Print icon.

Product presets (for Windows only)

Printer driver presets make printing a snap. You can also create presets of your own.

Product settings for Windows

A Access the printer settings.
& “Accessing the printer driver for Windows” on page 36

B Select a Printing Presets in the Shortcuts tab. Product settings are automatically set to the values displayed in the
pop-up window.

2-sided printing (for Windows only)

Use the printer driver to print on both sides of the paper.

Two types of 2-sided printing are available: standard and folded booklet.

2-sided printing is only available for the following papers and sizes.
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Paper Size

Plain paper Legal, Letter, A4, B5, A5, A6

Epson Bright White Ink Jet Paper A4

Note:
❏ This feature is not available for Mac OS X.

❏ This feature may not be available at some settings.

❏ This feature may not be available when the product is accessed over a network or is used as a shared printer.

❏ The loading capacity differs during 2-sided printing.
& “Selecting Paper” on page 20

❏ Only use papers that are suitable for 2-sided printing. Otherwise, the printout quality may deteriorate.

❏ Depending on the paper and the amount of ink used to print text and images, ink may bleed through to the other side of
the paper.

❏ The surface of the paper may be smeared during 2-sided printing.

❏ This feature is available only when EPSON Status Monitor 3 is enabled. To enable the status monitor, access the printer
driver and click the Maintenance tab followed by the Extended Settings button. In the Extended Settings window,
check the Enable EPSON Status Monitor 3 check box.

Product settings for Windows

A Access the printer settings.
& “Accessing the printer driver for Windows” on page 36

B Choose the desired 2-sided printing option in the Page Layout tab. To print folded booklets, select Folded
Booklet.

C Check the other settings and print.

Note:
❏ The actual binding margin may be different from the specified settings depending on your application.

Experiment with a few sheets to examine actual results before printing the entire job.

❏ Make sure that the ink is completely dry before reloading the paper.
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Fit to page printing

Lets you automatically enlarge or reduce the size of your document to fit the paper size selected in the printer driver.

Note:
This feature may not be available at some settings.

Product settings for Windows

A Access the printer settings.
& “Accessing the printer driver for Windows” on page 36

B Select Reduce/Enlarge Document and By Output Paper Size in the Page Layout tab, and then select the size of
the paper you are using from the drop-down list.

C Check the other settings and print.

Product settings for Mac OS X

A Access the Print dialog box.
& “Accessing the printer driver for Mac OS X” on page 37

B Choose Scale to fit paper size for Destination Paper Size in the Paper Handling pane, and then select the size of
the paper you are using from the pop-up menu.

C Check the other settings and print.
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Pages per sheet printing

Lets you use the printer driver to print two or four pages on a single sheet of paper.

Note:
This feature may not be available at some settings.

Product settings for Windows

A Access the printer settings.
& “Accessing the printer driver for Windows” on page 36

B Select Multi-Page and then select the Pages per Sheet in the Page Layout tab.

C Choose the desired number of pages and page order.

D Check the other settings and print.

Product settings for Mac OS X

A Access the Print dialog box.
& “Accessing the printer driver for Mac OS X” on page 37

B Select the desired number of Pages per Sheet and the Layout Direction (page order) in the Layout pane.

C Check the other settings and print.

     User’s Guide

Printing

47



Sharing the Product for Printing

Setup for Windows

These instructions tell you how to set up your product so other users on the network can share it.

First you will set up the product as a shared printer on the computer directly connected to it. Then you will add the
product to each network computer that will access it.

Note:
❏ These instructions are for small networks only. To share the product on a large network, consult your network

administrator.

❏ The screen shots in the following section are from Windows 7.

Setting up the product as a shared printer

Note:
❏ To set up the product as a shared printer in Windows 8, 7 or Vista, you will need an account with administrator

privileges and the password if you log on as a standard user.

❏ To set up the product as a shared printer in Windows XP, you must log on to a Computer Administrator account.

Follow the steps below on the computer that is connected directly to the product:

A Windows 8:
Select Control Panel from Settings. Then select Devices and Printers from the Hardware and Sound
category.

Windows 7: 
Click the start button, select Devices and Printers.

Windows Vista: 
Click the start button, select Control Panel, and then select Printer from the Hardware and Sound category.

Windows XP: 
Click Start and select Control Panel, and then select Printers and Faxes, from the Printers and Other
Hardware category.

B Windows 8 and 7: 
Right-click on the product, or press and hold the product, and select Printer properties, and then select
Sharing. Then select the Change Sharing Options button.

Windows Vista: 
Right-click the icon for your product, and then click Sharing. Click the Change sharing options button and
then click Continue.

Windows XP: 
Right-click the icon for your product, then click Sharing.
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C Select Share this printer, then type a Share name.

Note:
Do not use spaces or hyphens in the share name.

If you want to automatically download printer drivers for computers that are running different versions of
Windows, click Additional Drivers and select the environment and the operating systems of the other
computers. Click OK, then insert the product software disk.

D Click OK or Close (if you installed additional drivers).

Adding the product to the other network computers

Follow these steps to add the product to each network computer that will access it.

Note:
Your product must be set up as a shared printer on the computer to which it is connected before you can access it from
another computer.
& “Setting up the product as a shared printer” on page 48

A Windows 8: 
Select Control Panel from Settings. Then select Devices and Printers from the Hardware and Sound
category.

Windows 7: 
Click the start button, select Devices and Printers.
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Windows Vista: 
Click the start button, select Control Panel, and then select Printer from the Hardware and Sound category.

Windows XP: 
Click Start and select Control Panel, and then select Printers and Faxes, from the Printers and Other
Hardware category.

B Windows 8, 7 and Vista: 
Select the Add a printer button.

Windows XP: 
Click the Add a printer button. The Add Printer Wizard appears. Click the Next button.

C Windows 8: 
Go to Step 4.

Windows 7 and Vista: 
Click Add a network, wireless or Bluetooth printer, and then click Next.

Windows XP: 
Select A network printer, or a printer attached to another computer, then click Next.

D Follow the on-screen instructions to select the product you want to use.

Note:
Depending on the operating system and the configuration of the computer to which the product is connected, the Add Printer
Wizard may prompt you to install the printer driver from the product software disk. Click the Have Disk button and follow
the on-screen instructions.

Setup for Mac OS X

To set up your product on a Mac OS X network, use the Printer Sharing setting. See your Macintosh documentation for
details.
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Scanning

Let’s Try Scanning

Starting a Scan

Let’s scan a document to get used to the process.

A Place your original(s) on the scanner glass.
& “Placing Originals” on page 28

B Start Epson Scan.

❏ Windows 8:
Select the EPSON Scan icon on the desktop, or select EPSON Scan from the Start screen.

❏ Windows 7, Vista and XP:
Double-click the Epson Scan icon on the desktop.

❏ Mac OS X:
Select Applications > Epson Software > EPSON Scan.

C Select Home Mode.
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D Select Text/Line Art as the Document Type setting.

E Click Preview.

F Click Scan.
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G Click OK.

Your scanned image is saved.

Image Adjustment Features

Epson Scan offers a variety of settings for improving color, sharpness, contrast, and other aspects affecting image
quality.

See the Help for more details on Epson Scan.

Histogram Provides a graphical interface for adjusting highlight, shadow, and gamma levels
individually.
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Tone Correction Provides a graphical interface for adjusting tone levels individually.

Image Adjustment Adjusts brightness and contrast and the balance of red, green, and blue colors in the
overall image.

Color Palette Provides a graphical interface for adjusting mid-tone levels, such as skin tones, without
affecting the highlight and shadow areas of the image.

Unsharp Mask Sharpens the edges of image areas for an overall clearer image.

Descreening Removes rippled patterns (known as moiré) that can appear in subtly shaded image areas
such as skin tones.

Color Restoration Restores the colors in faded photos automatically.
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Backlight Correction Removes shadows from photos that have too much background light.

Dust Removal Removes dust marks from your originals automatically.

Text Enhancement Enhances text recognition when scanning text documents.

Auto Area Segmentation Makes Black&White images clearer and text recognition more accurate by separating the
text from the graphics.

Color Enhance Enhance a certain color. You can select from red, blue, or green.

Basic Scanning from the Control Panel

You can scan documents and send the scanned image from the product to a connected computer. Make sure you have
installed software for the product on your computer and connected to the computer.
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For XP-310 Series/XP-410 Series

Note for XP-410 Series:
If you want to scan your data to a memory card, insert a memory card first.
& “Inserting a Memory Card” on page 26

A Place your original on the scanner glass.
& “Placing Originals” on page 28

B Enter the Scan mode from the Home menu.

C Select a scan menu item. Use l or r to select a menu, and press OK.

& “Scan Mode” on page 75

D If you select Scan to PC, select your computer. If you select Scan to Memory Card, make scanning settings such
as saving format and scan area.

Note:
❏ If the product is connected to a network, you can select the computer to which you want to save the scanned

image.

❏ You can change the computer name displayed on the control panel using Epson Event Manager.

❏  For XP-410 Series: If you want to use the Scan to Cloud service, see the Epson Connect guide, which is available
on the Epson Connect portal site.
& “Using Epson Connect Service” on page 8

E Press x to start scanning.

Your scanned image is saved.

For XP-210 Series

A Place your original on the scanner glass.
& “Placing Originals” on page 28

B Press the two start buttons simultaneously.

Your scanned image is saved in PDF format on your computer.

Scan mode menu list

Refer to the section below for the Scan mode menu list.
& “Scan Mode” on page 75
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Basic Scanning from Your Computer

Scanning in Full Auto Mode

Full Auto Mode lets you scan quickly and easily, without selecting any settings or previewing your image. This mode is
useful when you need to scan your originals at 100% size.

Note:
❏ This mode is not available when the Automatic Document Feeder is installed.

❏ See the Help for more details on Epson Scan.

A Place your original(s).

B Start Epson Scan.

& “Starting Epson Scan Driver” on page 71

C Select Full Auto Mode from the Mode list.
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Note:
If the Show this dialog box before next scan check box is cleared, Epson Scan starts scanning immediately without
displaying this screen. To return to this screen, click Cancel in the Scanning dialog box during scanning.

D Click Scan. Epson Scan starts scanning in Full Auto Mode.

Epson Scan previews each image, detects what type of original it is, and selects the scan settings automatically.

Your scanned image is saved.

Scanning in Home Mode

Home Mode lets you customize some scanning settings and check the changes you have made in a preview image. This
mode is useful for basic scanning of photos and graphics.

Note:
❏ In Home Mode, you can only scan from the scanner glass.

❏ See the Help for more details on Epson Scan.
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A Place your original(s).
& “Placing Originals” on page 28

B Start Epson Scan.
& “Starting Epson Scan Driver” on page 71

C Select Home Mode from the Mode list.

D Select the Document Type setting.

E Select the Image Type setting.

F Click Preview.
& “Previewing and Adjusting the Scan Area” on page 64

G Adjust the exposure, brightness, and other image quality settings.

H  Click Scan.
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I  In the File Save Settings window, select the Type setting and then click OK.

Note:
If the Show this dialog box before next scan check box is cleared, Epson Scan starts scanning immediately without
displaying the File Save Settings window.

Your scanned image is saved.

Scanning in Office Mode

Office Mode lets you quickly scan text documents without previewing your image.

Note:
See the Help for more details on Epson Scan.

A Place your original(s).
& “Placing Originals” on page 28

B Start Epson Scan.
& “Starting Epson Scan Driver” on page 71

     User’s Guide

Scanning

60



C Select Office Mode from the Mode list.

D Select the Image Type setting.

E Select the Document Source setting.

F Select the size of your original as the Size setting.

G Select an appropriate resolution for your original(s) as the Resolution setting.

H Click Scan.
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I In the File Save Settings window, select the Type setting and then click OK.

Note:
If the Show this dialog box before next scan check box is cleared, Epson Scan starts scanning immediately without
displaying the File Save Settings window.

Your scanned image is saved.

Scanning in Professional Mode

Professional Mode gives you total control of your scanning settings and lets you check the changes you have made in a
preview image. This mode is recommended for advanced users.

Note:
See the Help for more details on Epson Scan.

A Place your original(s).
& “Placing Originals” on page 28

B Start Epson Scan.
& “Starting Epson Scan Driver” on page 71
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C Select Professional Mode from the Mode list.

D Select the type of original(s) you are scanning as the Document Type setting.

E Select the Document Source setting.

F If you select Reflective as the Document Type setting, select Photo or Document as the Auto Exposure Type
setting.
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G Select the Image Type setting.

H Select an appropriate resolution for your original(s) as the Resolution setting.

I Click Preview to preview your image(s). The Preview window opens and displays your image(s).
& “Previewing and Adjusting the Scan Area” on page 64

J Select the size of the scanned image(s) as the Target Size setting if necessary. You can scan your images at their
original size, or you can reduce or enlarge their size by selecting Target Size.

K Adjust the image quality if necessary.
& “Image Adjustment Features” on page 53

Note:
You can save the settings you make as a group of custom settings with a Name, and later apply these custom settings
when scanning. Your custom settings are also available in Epson Event Manager.

See the Help for more details on Epson Event Manager.

L  Click Scan.

M  In the File Save Settings window, select the Type setting and then click OK.

Note:
If the Show this dialog box before next scan check box is cleared, Epson Scan starts scanning immediately without
displaying the File Save Settings window.

Your scanned image is saved.

Previewing and Adjusting the Scan Area

Selecting a preview mode

Once you have selected your basic settings and resolution, you can preview your image and select or adjust the image
area in a Preview window. There are two types of preview.

❏ Normal preview displays your previewed image(s) in their entirety. You can select the scan area and make any
image quality adjustments manually.

❏ Thumbnail preview displays your previewed image(s) as thumbnail(s). Epson Scan automatically locates the
edges of your scan area, applies automatic exposure settings to the image(s), and rotates the image(s) if necessary.
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Note:
❏ Some of the settings that you change after previewing an image are reset if you change the preview mode.

❏ Depending on your document type and the Epson Scan mode you are using, you may not be able to change the preview
type.

❏ If you preview image(s) without the Preview dialog displayed, image(s) are displayed in the default preview mode. If you
preview with the Preview dialog displayed, image(s) are displayed in the preview mode that was displayed just before
previewing.

❏ To resize the Preview window, click and drag the corner of the Preview window.

❏ See the Help for more details on Epson Scan.

Creating a marquee

A marquee is a moving dotted line that appears on the edges of your preview image to indicate the scan area.

Do one of the following to draw a marquee.

❏ To draw the marquee manually, position the pointer in the area where you want to place the corner of your
marquee and click. Drag the cross-hairs over the image to the opposite corner of the desired scan area.

❏ To draw the marquee automatically, click the  auto locate icon. You can only use this icon when you are
viewing a normal preview and you only have one document on the scanner glass.

❏ To draw the marquee at a specified size, type in a new width and height in the Document Size setting.

❏ For best results and image exposure, make sure all sides of the marquee are located inside the preview image. Do
not include any areas around the preview image in the marquee.

Adjusting a marquee

You can move the marquee and adjust its size. If you are viewing a normal preview, you can create multiple marquees
(up to 50) on each image to scan different image areas as separate scan files.

To move the marquee, position your cursor inside the marquee. The pointer becomes a hand. Click
and drag the marquee to the desired location.

To resize the marquee, position your cursor over the edge or corner of the marquee.

The pointer becomes a straight or angled double-arrow. Click and drag the edge or corner to the
desired size.
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To create additional marquees of the same size, click this icon.

To delete a marquee, click inside the marquee and click this icon.

To activate all marquees, click this icon.

Note:
❏ To restrict the movement of the marquee to vertical or horizontal only, hold down the Shift key as you move the

marquee.

❏ To restrict the size of the marquee to the current proportions, hold down the Shift key as you resize the marquee.

❏ If you draw multiple marquees, make sure you click All in the Preview window before you scan. Otherwise, only the area
inside the last marquee you drew will be scanned.

Various Types of Scanning

Scanning a Magazine

First of all, place your magazine and start Epson Scan.
& “Starting a Scan” on page 51

A Select Home Mode from the Mode list.
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B Select Magazine as the Document Type setting.

C Click Preview.

D Adjust the exposure, brightness, and other image quality settings.

See the Help for more details on Epson Scan.

E Click Scan.

F Select PDF as the Type setting, and then click OK.

Your scanned image is saved.
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Scanning Multiple Documents to a PDF File

First of all, place your document and start Epson Scan.
& “Starting a Scan” on page 51

A Select Professional Mode from the Mode list.

B Select the Document Source setting.

C Click Preview.

D Adjust the exposure, brightness, and other image quality settings.

See the Help for more details on Epson Scan.

     User’s Guide

Scanning

68



E Click Scan.

F Select PDF as the Type setting, and then click OK.

Note:
If the Show Add Page dialog after scanning check box is cleared, Epson Scan automatically saves your document
without displaying the Add Page Confirmation window.

G Epson Scan starts scanning your document.

H If you want to scan more pages, click Add page.
Load the document and scan again, repeating as necessary for each page.

If you have finished scanning, go to step 9.

     User’s Guide

Scanning

69



I Click Edit page or Save File.

Edit page Select this button if you want to delete or reorder any of the pages. Then use the icons on the
bottom of the Editing Page window to select, rotate, reorder, and delete pages.
See the Help for more details on Epson Scan.

Click OK when you are finished editing your pages.

Save File Select this button when you are finished.

The pages are saved in one PDF file.

Scanning a Photo

First of all, place your photo on the scanner glass and start Epson Scan.
& “Starting a Scan” on page 51
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A Select Home Mode from the Mode list.

B Select Photograph as the Document Type setting.

C Click Preview.

D Adjust the exposure, brightness, and other image quality settings.

See the Help for more details on Epson Scan.

E Click Scan.

F Select JPEG as the Type setting, and then click OK.

Your scanned image is saved.

Software Information

Starting Epson Scan Driver

This software lets you control all aspects of scanning. You can use this as a standalone scanning program or use it with
another TWAIN-compliant scanning program.
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How to start

❏ Windows 8:
Select the Epson Scan icon on the desktop.
Or, select Epson Scan from the Start screen.

❏ Windows 7, Vista and XP:
Double-click the EPSON Scan icon on the desktop.
Or, select the start button icon or Start > All Programs or Programs > EPSON > EPSON Scan > EPSON
Scan.

❏ Mac OS X:
Select Applications > Epson Software > EPSON Scan.

How to access the help

Click the Help button on the Epson Scan driver.

Starting Other Scanning Software

Note:
Some scanning software may not be included in some countries.

Epson Event Manager

This lets you assign any of the product buttons to open a scanning program. You can also save frequently used
scanning settings, which can really speed up your scanning projects.

How to start
❏ Windows 8:

Right-click on the Start screen, or swipe from the bottom or top edge on the Start screen, and select All apps >
Epson Software > Event Manager.

❏ Windows 7, Vista and XP:
Select the start button or Start > All Programs or Programs > Epson Software > Event Manager.

❏ Mac OS X:
Select Applications > Epson Software, and then double-click the Launch Event Manager icon.

How to access the help
❏ Windows:

Click the  icon in the upper right corner of the screen.

❏ Mac OS X:
Click menu > Help > Epson Event Manager Help.
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Menu List of Control Panel

You can use this product as a printer, copier, and scanner. When using one of these functions, except the printer
function, select your desired function by selecting the corresponding Mode on the control panel. Each mode’s main
screen appears as you select the mode.

Note:
This function is available with XP-310 Series/XP-410 Series.

Copy Mode

XP-410 Series
Press d to see the menu.

Menu Setting item and description

Print Settings Density -4 to +4

Layout With Border, Borderless*1

Reduce/Enlarge Actual Size, Auto Fit Page, 10×15cm->A4, A4->10×15cm,
13×18->10×15, 10×15->13×18, A5->A4, A4->A5, Custom Size

Paper Size A4, A5, 10×15cm(4×6in), 13×18cm(5×7in)

Paper Type Plain Paper, Photo Paper

Quality Draft*2, Standard Quality, Best

XP-310 Series
Press d to see the menu.

Menu Setting item and description

Settings Layout With Border, Borderless*1

Reduce/Enlarge Actual Size, Auto Fit, Custom

Custom Size Specify a percentage to reduce or enlarge your copy. Disabled
when Auto Fit is selected.

Paper Size A4, 10×15cm(4×6in), 13×18cm(5×7in)

Paper Type Plain Paper, Photo Paper

Quality Draft, Standard Quality, Best

Density -4 to +4

*1 Your image is slightly enlarged and cropped to fill the sheet of paper. Print quality may decline in the top and bottom areas of the
printout, or the area may be smeared when printing.

*2 For users in Belgium, draft mode is not available.
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Print Photo Mode

XP-410 Series
Press d to see the menu.

Menu Setting item and description

Select Photos Select by Date

Cancel Photo Selection

Display Options Select how to display photos on the LCD screen. Thumbnail shows a thumbnail view of your
photos and allows you to select photos to print quickly. To select photos to print in thumbnail view,
select a photo using the arrow keys and specify the number of copies using the +/- buttons. The
number of copies is displayed on each of the selected thumbnail images.

Print Settings Paper Size*1 10x15cm(4x6in), 13x18cm(5x7in), A4

Paper Type*1 Photo Paper, Plain Paper

Borderless*1 With Border, Borderless*2

Quality*1 Standard Quality, Best

Fix Red-Eye*3 Off-Current, On-Current, Off-All, On-All

Crop/Zoom You can crop (zoom in) a specified portion of a selected photo by moving a crop frame using the
arrow buttons and +/- buttons.

Select Group If you have more than 999 images on your memory card, images are automatically divided into
groups and the group selection screen is displayed. Select the group that contains the image you
want to print. Images are sorted by the date they were taken. Use this menu to select another
group.

XP-310 Series
Press d to see the menu.

Menu Setting item and description

Settings Paper Size*1 10x15cm(4x6in), 13x18cm(5x7in), A4

Paper Type*1 Photo Paper, Plain Paper

Borderless*1 With Border, Borderless*2

Quality*1 Standard Quality, Best

*1 If you have selected multiple photos, these settings are applied to the all photos.

*2 Your image is slightly enlarged and cropped to fill the sheet of paper. Print quality may decline in the top and bottom areas of the
printout, or the area may be smeared when printing.

*3 This setting does not change your original image. It only affects your printout. Depending on the type of photo, parts of the image
other than the eyes may be corrected.
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Scan Mode

XP-410 Series

Menu Setting item and description

Scan to Memory Card Format JPEG, PDF

Color Color, B&W

Scan Area*1 A4, Auto Cropping, Max Area

Document Text, Photograph

Resolution 200dpi, 300dpi, 600dpi

Contrast -4 to +4

Scan to Cloud For instructions on use, see the Epson Connect guide. The guide is available on the Epson Connect
portal site.
& “Using Epson Connect Service” on page 8

Scan to PC (JPEG) & “Basic Scanning from the Control Panel” on page 55

Scan to PC (PDF)

Scan to PC (Email)

Scan to PC (WSD) This feature is only available for English versions of Windows 8/7/Vista.

*1 If the edges of the photo are faint, try changing this setting.

XP-310 Series

Menu Setting and Options

To PC (JPEG) & “Basic Scanning from the Control Panel” on page 55

To PC (PDF)

To PC (Email)

To PC (WSD) This feature is only available for English versions of Windows 8/7/Vista.
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More Functions Mode

XP-410 Series

Menu Setting item and description

Copy/Restore Photos Color Restoration Select On to automatically restore color of a faded
photo.

Display Options Select how to display photos on the LCD screen.

Print Settings Select the paper size, quality, and whether or not to
print with a border (margins).

Crop/Zoom You can crop (zoom in) a specified portion of a
selected photo by moving a crop frame using the
arrow buttons and +/- buttons.

Photo Layout Sheet Print layout 2-up, 4-up, 8-up, 20-up, Upper 1/2, Lower 1/2, Photo
ID

Paper Size 10x15cm(4x6in), 13x18cm(5x7in), A4

Paper Type Photo Paper, Plain Paper

Layout Method Place photos manually allows you to lay out photos
confirming a layout view.

Select Photos & “Print Photo Mode” on page 74

Display Options

Print Settings

Crop/Zoom

Slide Show Images in a memory card are displayed on the LCD screen one by one. Press OK to print a displayed
image.
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Menu Setting item and description

Personal Stationery Lined Papers You can print lined paper, graph paper, or music
paper.

Writing Papers You can print your original lined papers with or
without a photo set as the background.

Calendar You can print monthly or weekly calendars. For
monthly calendars, you can specify the year and
month.

Message Card You can create your own message cards with or
without a photo or a pre-designed image set as the
decoration.
& “Printing message cards (XP-410 Series only)” on
page 33

Origami You can create original envelopes with or without a
pre-designed image set as the background or as the
decoration. Two types of envelope are available. After
printing, fold the paper following the instruction
sheet that can be printed from the Origami Envelope
Instruction menu.
& “Printing origami envelopes (XP-410 Series only)”
on page 34

Personal Stationery Mode

XP-310 Series

Menu Setting item and description

Lined Papers Lined Papers You can print lined paper, graph paper, or music
paper.

Writing Papers Writing Papers You can print your original lined papers with or
without a photo set as the background.

Calendar Calendar You can print monthly or weekly calendars. For
monthly calendars, you can specify the year and
month.
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Wi-Fi Setup Mode

XP-410 Series

Menu Setting item and description

Wi-Fi Setup Wizard For details on the setting items, see the online Network Guide.

Push Button Setup (WPS)

PIN Code Setup (WPS)

Wi-Fi Direct Routerless
Setup

Wi-Fi Auto Connect

Confirm Wi-Fi Settings You can see the current network settings and print a network status sheet.

Disable Wi-Fi Network problems may be resolved by disabling or initializing the Wi-Fi settings, and then making
the settings again.
For details, see the online Network Guide.

XP-310 Series

Menu Setting item and description

Wi-Fi Setup Wizard For details on the setting items, see the online Network Guide.

Push Button (WPS)

PIN Code (WPS)

Wi-Fi Direct Setup

Wi-Fi Auto Connect

Print Status Sheet You can see the current network settings and print a network status sheet.

Disable Wi-Fi Network problems may be resolved by disabling or initializing the Wi-Fi settings, and then making
the settings again.
For details, see the online Network Guide.

Setup Mode

Menu Setting item and description

Ink Levels Checks the status of ink cartridges.

Maintenance Nozzle Check Prints a nozzle check pattern to check the condition of
the print head.

Head Cleaning Cleans the print head to improve the condition of the
print head.

Head Alignment Adjusts the alignment of the print head.

Ink Cartridge Replacement Select to replace ink cartridges.
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Menu Setting item and description

Printer Setup Sound*1 Select Off to turn off beep sound of buttons.

Power Off Timer & “Saving Power” on page 102

Sleep Timer

Language You can change the language displayed on the LCD
panel.

Wi-Fi Settings Wi-Fi Setup See the online Network Guide. You can access the
Wi-Fi Setup menus directly by selecting Wi-Fi Setup
from the Home menu.Manual Wi-Fi Setup*1

Wi-Fi Connection Check You can check the network connection status, and
print the report. If there is any problem with the
connection, the report helps you find the solution.

Confirm Wi-Fi Settings*2 You can see the current network settings and print a
network status sheet.

Epson Connect
Services*1

Status You can check whether your printer is registered or
connected to Epson Connect service.
For instructions on use, see the Epson Connect guide.
The guide is available on the Epson Connect portal
site.
& “Using Epson Connect Service” on page 8

Email Address You can see your e-mail address registered in Epson
Connect.

Suspend/Resume Suspend/resume all Epson Connect services.

Restore Default Settings Delete your registered printer and initializes Epson
Connect settings to the factory default settings.

Google Cloud Print
Services*1

Status You can check whether your printer is registered or
connected to Google Cloud Print service.
For instructions on use, see the Epson Connect guide.
The guide is available on the Epson Connect portal
site.
& “Using Epson Connect Service” on page 8

Suspend/Resume Suspend/resume all Google Cloud Print services.

Restore Default Settings Delete your registered printer and initializes Google
Cloud Print settings to the factory default settings.

File Sharing Setup USB, Wi-Fi Select which type of computer you want to give write
access to the memory card. You can select a
USB-connected or a Wi-Fi-connected computer.

Restore Default Settings Wi-Fi Settings Initializes Wi-Fi settings to the factory default settings.

All except Wi-Fi Settings Initializes all settings except for Wi-Fi settings to the
factory default settings.

All Settings Initializes all settings to the factory default settings.

*1 XP-310 Series does not have these functions.

*2 The menu name for XP-310 Series is “Print Status Sheet”.
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Replacing Ink Cartridges

Ink Cartridge Safety Instructions, Precautions, and
Specifications

Safety instructions

Observe the following when handling the ink cartridges:

❏ Keep ink cartridges out of the reach of children.

❏ Be careful when you handle used ink cartridges, as there may be some ink around the ink supply port.
If ink gets on your skin, wash the area thoroughly with soap and water.
If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems continue after a
thorough flushing, see a doctor immediately.
If ink gets into your mouth, spit it out immediately and see a doctor right away.

❏ Do not remove or tear the label on the cartridge; this can cause leakage.

❏ Do not remove the transparent seal from the bottom of the cartridge; otherwise, the cartridge may become
unusable.

❏ Do not disassemble or remodel the ink cartridge, otherwise you may not be able to print normally.

     User’s Guide

Replacing Ink Cartridges

80



❏ Do not touch the green IC chip or the small window on the side of the cartridge. Doing so may prevent normal
operation and printing.

❏ Do not leave the product with the ink cartridges removed or do not turn off the product during cartridge
replacement. Otherwise, ink remaining in the print head nozzles will dry out and you may not be able to print.

Precautions on ink cartridge replacement

Read all of the instructions in this section before replacing the ink cartridges.

❏ Epson recommends the use of genuine Epson ink cartridges. Epson cannot guarantee the quality or reliability of
non-genuine ink. The use of non-genuine ink may cause damage that is not covered by Epson’s warranties, and
under certain circumstances, may cause erratic product behavior. Information about non-genuine ink levels may
not be displayed.

❏ Gently shake only the black ink cartridge four or five times before opening the package. Do not shake the other
color cartridges.

❏ Do not shake ink cartridges too vigorously; otherwise ink may leak from the cartridge.

❏ This product uses ink cartridges equipped with an IC chip that monitors information such as the amount of
remaining ink for each cartridge. This means that even if the cartridge is removed from the product before it is
expended, you can still use the cartridge after reinserting it back into the product. However, when reinserting a
cartridge, some ink may be consumed to guarantee product performance.

❏ You cannot use the cartridge that came with your product for the replacement.

❏ To maintain optimum print head performance, some ink is consumed from all cartridges not only during printing
but also during maintenance operations such as ink cartridge replacement and print head cleaning.

❏ If you need to remove an ink cartridge temporarily, be sure to protect the ink supply area from dirt and dust. Store
the ink cartridge in the same environment as the product. When storing the cartridge, be sure that its label
identifying the color of the ink cartridge is facing upward. Do not store ink cartridges upside down.

❏ The ink supply port is equipped with a valve designed to contain the release of excess ink; there is no need to supply
your own covers or plugs. However, careful handling is recommended. Do not touch the supply port of the ink
cartridge or its surrounding area.

❏ For maximum ink efficiency, only remove an ink cartridge when you are ready to replace it. Ink cartridges with
low ink status may not be used when reinserted.
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❏ Do not open the ink cartridge package until you are ready to install it in the product. The cartridge is vacuum
packed to maintain its reliability. If you leave a cartridge unpacked for a long time before using it, normal printing
may not be possible.

❏ Install all ink cartridges; otherwise, you cannot print.

❏ When color ink is expended and black ink still remains, you can continue printing temporarily with black ink
only. For more information refer to “Temporarily Printing with Black Ink When Color Ink Cartridges are
Expended” on page 85.

❏ If an ink cartridge is running low, prepare a new ink cartridge.

❏ Be careful not to break the hooks on the side of the ink cartridge when you remove it from the package.

❏ You must remove the yellow tape from the cartridge before installing it; otherwise, print quality may decline or
you may not be able to print.

❏ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least
three hours before using it.

❏ Store ink cartridges in a cool, dark place.

❏ Store ink cartridges with their labels facing upward. Do not store cartridges upside down.

Ink Cartridge Specifications

❏ Epson recommends using the ink cartridge before the date printed on the package.

❏ The ink cartridges packaged with your product are partly used during initial setup. In order to produce high
quality printouts, the print head in your product will be fully charged with ink. This one-off process consumes a
quantity of ink and therefore these cartridges may print fewer pages compared to subsequent ink cartridges.

❏ Quoted yields may vary depending on the images that you are printing, the paper type that you are using, the
frequency of your prints and environmental conditions such as temperature.

❏ To ensure you receive premium print quality and to help protect your print head, a variable ink safety reserve
remains in the cartridge when your product indicates to replace the cartridge. The yields quoted for you do not
include this reserve.

❏ Although the ink cartridges may contain recycled materials, this does not affect product function or performance.

❏ When printing in monochrome or grayscale, color inks instead of black ink may be used depending on the paper
type or print quality settings. This is because a mixture of color inks is used to create black.
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Checking the Ink Cartridge Status

For Windows

Note:
❏ The order in which ink cartridges are listed varies depending on the product.

❏ When an ink cartridge is running low, the Low Ink Reminder screen automatically appears. You can also check the ink
cartridge status from this screen. If you do not want to display this screen, first access the printer driver and then click the
Maintenance tab, Extended Settings button, and then Monitoring Preferences button. On the Monitoring
Preferences screen, clear the See Low Ink Reminder alerts check box.

To check the ink cartridge status, do one of the following:

❏ Double-click the product shortcut icon on your Windows taskbar. To add a shortcut icon to the taskbar, see the
following section:
& “From the shortcut icon on the taskbar” on page 37

❏ Open the printer driver, click the Maintenance tab, then click the EPSON Status Monitor 3 button. A graphic
displays the ink cartridge status.

Note:
❏ If EPSON Status Monitor 3 does not appear, access the printer driver and click the Maintenance tab and then

the Extended Settings button. In the Extended Settings window, check the Enable EPSON Status Monitor 3
check box.

❏ The ink levels displayed are an approximate indication.
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For Mac OS X

You can check the ink cartridge status using EPSON Status Monitor. Follow the steps below.

A Access the Epson Printer Utility 4.
& “Accessing the printer driver for Mac OS X” on page 37

B Click the EPSON Status Monitor icon. The EPSON Status Monitor appears.

Note:
❏ The graphic displays the ink cartridge status when EPSON Status Monitor was first opened. To update the ink cartridge

status, click Update.

❏ The order in which ink cartridges are listed varies depending on the product.

❏ The ink levels displayed are an approximate indication.

Using the control panel

Note:
This function is available with XP-310 Series/XP-410 Series.

A Enter Setup mode from the Home menu.
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B Select Ink Levels.

Note:
The ink levels displayed are an approximate indication.

Temporarily Printing with Black Ink When Color Ink
Cartridges are Expended

When color ink is expended and black ink still remains, you can continue printing for a short time using only black ink.
However, you should replace the expended ink cartridge(s) as soon as possible. See the following section to continue
printing temporarily with black ink.

Note:
❏ This feature is not available when photos and documents are printed or copied directly from the printer without using a

computer.

❏ The actual amount of time will vary depending on the usage conditions, images printed, print settings, and frequency of
use.

For Windows

Follow the steps below to continue printing temporarily with black ink.
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A When EPSON Status Monitor 3 tells you to cancel your print job, click Cancel or Cancel Print to cancel your
print job.

Note:
If the error stating that a color ink cartridge is expended originates with another computer on the network, you may
need to cancel the print job at the product. If the product is not equipped with an LCD screen, press the y button on
the product for three seconds to cancel the print job.

B Load plain paper or envelope.

C Access the printer settings.
& “Accessing the printer driver for Windows” on page 36

D Click the Main tab, and make suitable settings.

E Select plain papers or Envelope as the Type setting.

F Select the Grayscale check box in Print Options.

G Click OK to close the printer settings window.

     User’s Guide

Replacing Ink Cartridges

86



H Print your file.

I EPSON Status Monitor 3 is displayed on your computer screen again. Click Print in Black to print with black
ink.

For Mac OS X

Follow the steps below to continue printing temporarily with black ink.

A If printing can not be resumed, click the product icon in the Dock. If an error message is displayed prompting
you to cancel the print job, click Delete and follow the steps below to reprint the document with black ink.

Note:
If the error stating that a color ink cartridge is expended originates with another computer on the network, you may
need to cancel the print job at the product. If the product is not equipped with an LCD screen, press the y button on
the product for three seconds to cancel the print job.

For Mac OS X 10.8:
Click the  button, and if an error message appears, click OK. Follow the steps bellow to reprint the document
with black ink.

B Open System Preferences, click Print & Scan (Mac OS X 10.8 or 10.7) or Print & Fax (Mac OS X 10.6 or 10.5),
and select the product from the Printers list. Next, click Options & Supplies and then Driver.

C Select On for Permit temporary black printing.
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D Load plain paper or envelope.

E Access the Print dialog box.
& “Accessing the printer driver for Mac OS X” on page 37

F Click the Show Details button (for Mac OS X 10.8 or 10.7) or the d button (for Mac OS X 10.6 or 10.5) to extend
this dialog box.

G Select the product you are using as the Printer setting, and then make suitable settings.

H Select Print Settings from the pop-up menu.

I Select plain papers or Envelope as the Media Type setting.

J Select the Grayscale check box.

K Click Print to close the Print dialog box.

Conserving Black Ink When the Cartridge Is Low (For
Windows Only)

The window below appears when black ink runs low and there is more color ink than black ink. It appears only when
plain papers is selected as the paper type, and Normal is selected as the Paper & Quality Options in the Advanced
tab.

The window gives you the option to either continue using black ink normally or conserve black ink by using a mixture
of color inks to create black.

❏ Click the Yes button to use a mixture of color inks to create black. You will see the same window the next time you
print a similar job.
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❏ Click the No button to continue using the remaining black ink for the job you are printing. You will see the same
window the next time you print a similar job, and again have the option to conserve black ink.

❏ Click Disable this feature to continue using the remaining black ink.

Replacing an Ink Cartridge

Using the control panel (XP-310 Series/XP-410 Series)

A When prompted to replace an ink cartridge, open the scanner unit and press OK. The ink cartridge holder
moves to the ink cartridge replacement position.
When you replace an ink cartridge before it is expended, select the following menu.
Setup > Maintenance > Ink Cartridge Replacement.

c Important:
Do not move the ink cartridge holder by hand; otherwise, you may damage the product.

B Pinch and remove the ink cartridge.
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Note:
Removed ink cartridges may have ink around the ink supply port, so be careful not to get any ink on the surrounding
area when removing the cartridges.

C If you replace the black ink cartridge, gently shake the new black ink cartridge four or five times and then
unpack. When replacing the other color cartridges, do not shake the cartridges. Just unpack them.

c Important:
❏ Be careful not to break the hooks on the side of the ink cartridge when you remove it from the package.

❏ Do not touch the green IC chip or the small window on the side of the cartridge. Doing so may prevent
normal operation and printing.

D Remove only the yellow tape.
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c Important:
❏ You must remove the yellow tape from the cartridge before installing it; otherwise, print quality may

decline or you may not be able to print.

❏ If you have installed an ink cartridge without removing the yellow tape, take the cartridge out of the
product, remove the yellow tape, and then reinstall it.

❏ Do not remove the transparent seal from the bottom of the cartridge; otherwise, the cartridge may become
unusable.

❏ Do not remove or tear the label on the cartridge; otherwise, ink will leak.

E Insert the cartridge and press it until it clicks. Make sure the top surface of the ink cartridges align.

F Close the scanner unit slowly and press the x button. Ink charging starts.

Note:
❏ The P light continues to flash while the product is charging ink. Do not turn off the product during ink charging.

If the ink charging is incomplete, you may not be able to print.

❏ If you had to replace an ink cartridge during copying, to ensure copy quality after ink charging is finished, cancel
the job that is copying and start again from placing the originals.

Ink cartridge replacement is complete. The product will return to its previous status.
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Using the control panel (XP-210 Series)

A Open the scanner unit.

B If the B light is on, press the y button.
If the B light is flashing or off, press the y button for six seconds until the ink cartridge holder moves.

The ink cartridge holder moves to the ink cartridge check position. The cartridge indicated by the  icon is
expended or low.

c Important:
Do not move the ink cartridge holder by hand; otherwise, you may damage the product. Always press the
y button to move it.
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C Press the y button again.
If more than one ink cartridge is expended, the ink cartridge holder moves to the  mark. This occurs each time
you press the y button until all expended ink cartridges have been indicated.

Once all of the expended ink cartridges have been indicated, the ink cartridge holder moves to the ink cartridge
replacement position when you press the y button.

D Pinch and remove the ink cartridge.

Note:
Removed ink cartridges may have ink around the ink supply port, so be careful not to get any ink on the surrounding
area when removing the cartridges.

E If you replace the black ink cartridge, gently shake the new black ink cartridge four or five times and then
unpack. When replacing the other color cartridges, do not shake the cartridges. Just unpack them.
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c Important:
❏ Be careful not to break the hooks on the side of the ink cartridge when you remove it from the package.

❏ Do not touch the green IC chip or the small window on the side of the cartridge. Doing so may prevent
normal operation and printing.

F Remove only the yellow tape.

c Important:
❏ You must remove the yellow tape from the cartridge before installing it; otherwise, print quality may

decline or you may not be able to print.

❏ If you have installed an ink cartridge without removing the yellow tape, take the cartridge out of the
product, remove the yellow tape, and then reinstall it.

❏ Do not remove the transparent seal from the bottom of the cartridge; otherwise, the cartridge may become
unusable.

❏ Do not remove or tear the label on the cartridge; otherwise, ink will leak.
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G Insert the cartridge and press it until it clicks. Make sure the top surface of the ink cartridges align.

H Close the scanner unit and press y. Ink charging starts. This process takes about two minutes to complete.

Note:
❏ The P light continues to flash while the product is charging ink. Do not turn off the product during ink charging.

If the ink charging is incomplete, you may not be able to print.

❏ If you had to replace an ink cartridge during copying, to ensure copy quality after ink charging is finished, cancel
the job that is copying and start again from placing the originals.

Ink cartridge replacement is complete. The product will return to its previous status.

For Windows

When you need to replace an expended ink cartridge, click How to in the status monitor window. Follow the on-screen
instructions to replace the cartridge.
For more information on using your computer to replace ink cartridges, see the section below.
& “For Windows” on page 119.
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If you need to replace an ink cartridge before it is low or expended, click the button on the Maintenance tab in your
printer driver.
& “Accessing the printer driver for Windows” on page 36

For more information on using the printer utilities, see the online help.

For Mac OS X

When you need to replace an expended ink cartridge, click How to in the status monitor window. Follow the on-screen
instructions to replace the cartridge.
For more information on using your computer to replace ink cartridges, see the section below.
& “For Mac OS X” on page 120.

If you need to replace an ink cartridge before it is low or expended, access the Epson Printer Utility 4. Then click the Ink
Cartridge Replacement icon.
& “Accessing the printer driver for Mac OS X” on page 37.
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Maintaining Your Product and Software

Checking the Print Head Nozzles

If you find that the printout is unexpectedly faint or that dots are missing, you may be able to identify the problem by
checking the print head nozzles.

You can check the print head nozzles from your computer by using the Nozzle Check utility or from the product by
using the buttons.

Using the Nozzle Check utility for Windows

Follow the steps below to use the Nozzle Check utility.

A Make sure that no warnings or errors are indicated in the control panel.

B Make sure that A4-size paper is loaded in the sheet feeder.

C Right-click the product icon on the taskbar, then select Nozzle Check.

If the product icon does not appear, refer to the following section to add the icon.
& “From the shortcut icon on the taskbar” on page 37

D Follow the on-screen instructions.

Using the Nozzle Check utility for Mac OS X

Follow the steps below to use the Nozzle Check utility.

A Make sure that no warnings or errors are indicated in the control panel.

B Make sure that A4-size paper is loaded in the sheet feeder.

C Access the Epson Printer Utility 4.
& “Accessing the printer driver for Mac OS X” on page 37

D Click the Nozzle Check icon.

E Follow the on-screen instructions.
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Using the control panel (XP-310 Series/XP-410 Series)

Follow the steps below to check the print head nozzles using the product control panel.

A Make sure that no warnings or errors are indicated in the control panel.

B Make sure that A4-size paper is loaded in the sheet feeder.

C Enter Setup mode from the Home menu.

D Select Maintenance.

E Select Nozzle Check and follow the instructions in the LCD screen to print a nozzle check pattern.

Below are two sample nozzle check patterns.

Compare the quality of the printed check page with the sample shown below. If there are no print quality
problems, such as gaps or missing segments in the test lines, the print head is fine.

If any segment of the printed lines is missing, as shown below, this could mean a clogged ink nozzle or a
misaligned print head.

& “Cleaning the Print Head” on page 99 
& “Aligning the Print Head” on page 101

Using the control panel (XP-210 Series)

Follow the steps below to check the print head nozzles using the product buttons.

A Make sure that no warnings or errors are indicated in the control panel.

B Turn off the product.

C Make sure that A4-size paper is loaded in the sheet feeder.

D Holding down the y button and press the P button to turn on the product.
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E When the product turns on, release both the buttons. The product prints the nozzle check pattern.

Below are two sample nozzle check patterns.

Compare the quality of the printed check page with the sample shown below. If there are no print quality
problems, such as gaps or missing segments in the test lines, the print head is fine.

If any segment of the printed lines is missing, as shown below, this could mean a clogged ink nozzle or a
misaligned print head.

& “Cleaning the Print Head” on page 99 
& “Aligning the Print Head” on page 101

Cleaning the Print Head

If you find that the printout is unexpectedly faint or that dots are missing, you may be able to solve these problems by
cleaning the print head, which ensures that the nozzles are delivering ink properly.

You can clean the print head from your computer using the Head Cleaning utility in the printer driver or from the
product by using the buttons.

c Important:
Do not open the scanner unit or turn off the product during head cleaning. If the head cleaning is incomplete, you may
not be able to print.

Note:
❏ Because print head cleaning uses some ink from all cartridges, clean the print head only if quality declines; for example,

if the printout is blurry or the color is incorrect or missing.

❏ Use the Nozzle Check utility first to confirm that the print head needs to be cleaned. This saves ink.

❏ When ink is low you may not be able to clean the print head. When ink is expended you cannot clean the print head.
Replace the appropriate ink cartridge first.

❏ If print quality has not improved after repeating this procedure about four times, turn the product off and wait for at
least six hours. Then run the nozzle check again and repeat the head cleaning if necessary. If print quality has still not
improved, contact Epson support.

❏ To maintain print quality, we recommend printing a few pages on a regular basis.
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Using the Head Cleaning utility for Windows

Follow the steps below to clean the print head using the Head Cleaning utility.

A Make sure that no warnings or errors are indicated in the control panel.

B Right-click the product icon on the taskbar, then select Head Cleaning.

If the product icon does not appear, refer to the following section to add the icon.
& “From the shortcut icon on the taskbar” on page 37

C Follow the on-screen instructions.

Using the Head Cleaning utility for Mac OS X

Follow the steps below to clean the print head using the Head Cleaning utility.

A Make sure that no warnings or errors are indicated in the control panel.

B Access the Epson Printer Utility 4.
& “Accessing the printer driver for Mac OS X” on page 37

C Click the Head Cleaning icon.

D Follow the on-screen instructions.

Using the control panel (XP-310 Series/XP-410 Series)

Follow the steps below to clean the print head using the product control panel.

A Make sure that no warnings or errors are indicated in the control panel.

B Enter Setup mode from the Home menu.

C Select Maintenance.

D Select Head Cleaning.

E Follow the instructions on the LCD screen to continue.
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Using the control panel (XP-210 Series)

Follow the steps below to clean the print head using the product buttons.

A Make sure that no warnings or errors are indicated in the control panel.

B Hold down the y button for three seconds.

The product starts cleaning the print head and the P light begins flashing.

C When the P light stops flashing, print a nozzle check pattern to confirm that the head is clean.
& “Checking the Print Head Nozzles” on page 97

Aligning the Print Head

If you notice a misalignment of vertical lines or horizontal banding, you may be able to solve this problem by using the
Print Head Alignment utility in your printer driver or by using the product buttons.

Refer to the appropriate section below.

Note:
Do not press y to cancel printing while printing a test pattern with the Print Head Alignment utility.

Using the Print Head Alignment utility for Windows

Follow the steps below to align the print head using the Print Head Alignment utility.

A Make sure that no warnings or errors are indicated in the control panel.

B Make sure A4-size paper is loaded in the sheet feeder.

C Right-click the product icon on the taskbar, then select Print Head Alignment.

If the product icon does not appear, refer to the following section to add the icon.
& “From the shortcut icon on the taskbar” on page 37

D Follow the on-screen instructions to align the print head.

Using the Print Head Alignment utility for Mac OS X

Follow the steps below to align the print head using the Print Head Alignment utility.

A Make sure that no warnings or errors are indicated in the control panel.
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B Make sure A4-size paper is loaded in the sheet feeder.

C Access the Epson Printer Utility 4.
& “Accessing the printer driver for Mac OS X” on page 37

D Click the Print Head Alignment icon.

E Follow the on-screen instructions to align the print head.

Using the control panel (XP-310 Series/XP-410 Series)

Follow the steps below to align the print head using the product control panel.

A Make sure that no warnings or errors are indicated in the control panel.

B Make sure that A4-size paper is loaded in the sheet feeder.

C Enter Setup mode from the Home menu.

D Select Maintenance.

E Select Head Alignment and follow the instructions in the LCD screen to print the patterns.

F Find the most solid pattern in each of #1 to #4 groups.

G Enter the pattern number for the most solid pattern in #1 group.

H Repeat step 7 for the other groups (#2 to #4).

I Finish aligning the print head.

Saving Power

The product enters sleep mode or turns off automatically if no operations are performed for a set period.
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You can adjust the time before power management is applied. Any increase will affect the product’s energy efficiency.
Please consider the environment before making any change.

Follow the steps below to adjust the time.

For Windows

A Access the printer settings.
& “Accessing the printer driver for Windows” on page 36

B Click the Maintenance tab, and then click the Printer and Option Information button.

C Select Off, 30 minutes, 1 hour, 2 hours, 4 hours, 8 hours, or 12 hours as the Power Off Timer setting, and click
the Send button.

D Select 3 minutes, 5 minutes, 10 minutes, or 15 minutes as the Sleep Timer setting, and click the Send button.

E Click the OK button.

For Mac OS X

A Access the Epson Printer Utility 4.
& “Accessing the printer driver for Mac OS X” on page 37

B Click the Printer Settings button. The Printer Settings screen appears.

C Select Off, 30 minutes, 1 hour, 2 hours, 4 hours, 8 hours, or 12 hours as the Power Off Timer setting.

D Select 3 minutes, 5 minutes, 10 minutes, or 15 minutes as the Sleep Timer setting.

E Click the Apply button.

Using the control panel (XP-310 Series/XP-410 Series)

A Enter Setup mode from the Home menu.

B Select Printer Setup.

C Select Power Off Timer.

D Select Off, 30minutes, 1h, 2h, 4h, 8h, or 12h.
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E Select Sleep Timer.

F Select 3minutes, 5minutes, 10minutes, or 15 minutes.

Making Network Service Settings

Note:
XP-212/XP-213/XP-216 do not support this function.

You can make network service settings such as Epson Connect, AirPrint, or Google Cloud Print using a Web browser
on your computer, smartphone, tablet PC, or laptop that is connected to the same network as the product.

Enter the product’s IP address in the address bar of the Web browser and search for the product.

<Example>

IPv4: http://192.168.11.46

IPv6: http://[fe80::226:abff:feff:37cd]/

Note:
You can check your product’s IP address on the product’s control panel or by printing a network status sheet.

For products with an LCD screen: & “Setup Mode” on page 78

For products without an LCD screen: Press  to print the network status sheet.
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When the product is found successfully, the product’s web page is displayed as shown below. Select the menu you
want.

The web page also allows you to check the product’s status and update the product’s firmware.

Cleaning the Product

Cleaning the exterior of the product

To keep your product operating at its best, clean it thoroughly several times a year by using the following instructions.

c Important:
Never use alcohol or thinner to clean the product. These chemicals can damage the product.

Note:
Close the paper support and the output tray when you are not using the product to protect the product from dust.

❏ Use a soft, dry, clean cloth to clean the LCD screen or touchpad. Do not use liquid or chemical cleaners.

❏ Use a soft, dry, clean cloth to clean the surface of the scanner glass. If the glass surface is stained with grease or some
other hard-to-remove material, use a small amount of glass cleaner and a soft cloth to remove it. Wipe off all
remaining liquid.

❏ Do not press the surface of the scanner glass with any force.
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❏ Be careful not to scratch or damage the surface of the scanner glass, and do not use a hard or abrasive brush to clean
it. A damaged glass surface can decrease the scan quality.

Cleaning the interior of the product

To keep your print results at their best, clean the roller inside by using the following procedure.

!Caution:
Be careful not to touch the parts inside the product.

c Important:
❏ Be careful to keep water away from the electronic components.

❏ Do not spray the inside of the product with lubricants.

❏ Unsuitable oils can damage the mechanism. Contact your dealer or a qualified service person if lubrication is
needed.

For product with LCD screen:

A Make sure that no warnings or errors are indicated in the control panel.

B  Load several sheets of A4-size plain paper in the sheet feeder.

C  Enter Copy mode from the Home menu.

D  Press x to make a copy without placing a document on the scanner glass.Repeat step 4 until the paper is not
smeared with ink.

For product without LCD screen:

A Make sure that no warnings or errors are indicated in the control panel.

B Load several sheets of A4-size plain paper in the sheet feeder.

C Press one of the x buttons to make a copy without placing a document on the scanner glass.

D Repeat step 3 until the paper is not smeared with ink.

Transporting the Product

If you need to transport your printer some distance, carefully prepare and repack it as described below. Use the original
box and packing materials, or a similar box that holds the printer snugly.
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c Important:
❏ When storing or transporting the product, avoid tilting it, placing it vertically, or turning it upside down;

otherwise ink may leak.

❏ Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may prevent the product
from printing.

Note:
The illustrations in this section may vary depending on the product.

A Remove all paper from the sheet feeder and make sure the product is off.

B Open the scanner unit and make sure the print head is in the home position on the right.

Note:
If the ink cartridge holder is not in the home position on the right, turn on the product and wait until the ink cartridge
holder locks in the far right position. Then turn off the product.
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C Secure the ink cartridge holder to the case with tape as shown, then close the scanner unit.

Note:
Do not place tape on the white flat cable inside the product.

D Unplug the power cord from the outlet, then disconnect the USB cable from the product.

E Close the paper support and the output tray.

F If you have raised the control panel, pull the release lever on the rear of the control panel until it clicks, and then
lower the control panel to store.

G Repack the product in the box, using the protective materials that came with it.

Note:
❏ Keep the product level during transport.

❏ Be sure to remove the protective materials from the product before using it again.
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Checking and Installing Your Software

Checking the software installed on your computer

To use the functions described in this User’s Guide, you need to install the following software.

❏ Epson Driver and Utilities

❏ Epson Easy Photo Print

❏ Epson Event Manager

Follow the steps below to check that the software is installed on your computer.

For Windows

A Windows 8: Select Control Panel from Settings.

Windows 7 and Vista: Click the start button and select Control Panel.

Windows XP: Click Start and select Control Panel.

B Windows 8,  7 and Vista: Select Uninstall a program from the Programs category.

Windows XP: Double-click the Add or Remove Programs icon.

C Check the list of currently installed programs.

For Mac OS X

A Double-click Macintosh HD.

B Double-click the Epson Software folder in the Applications folder and check the contents.

Note:
❏ The Applications folder contains software provided by third parties.

❏ To check that the printer driver is installed, click System Preferences on the Apple menu and then click Print & Scan
(for Mac OS X 10.8 or 10.7) or Print & Fax (for Mac OS X 10.6 or 10.5). Then locate your product in the Printers list
box.

Installing the software

Insert the product software disk that came with your product and select the software you want to install on the Software
Select screen.
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If you are using Mac OS X, or if your computer does not have a CD/DVD drive, go to the following Epson website to
download and install the software.
http://support.epson.net/setupnavi/

Uninstalling Your Software

You may need to uninstall and then reinstall your software to solve certain problems or if you upgrade your operating
system.

See the following section for information on determining what applications are installed.
& “Checking the software installed on your computer” on page 109

For Windows

Note:
❏ For Windows 8, 7 and Vista, you need an administrator account and password if you log on as a standard user.

❏ For Windows XP, you must log on to a Computer Administrator account.

A Turn off the product.

B Disconnect the product’s interface cable from your computer.

C Do one of the following.

Windows 8: Select Control Panel from Settings.

Windows 7 and Vista: Click the start button and select Control Panel.

Windows XP: Click Start and select Control Panel.

D Do one of the following.

Windows 8, 7 and Vista: Select Uninstall a program from the Programs category.

Windows XP: Double-click the Add or Remove Programs icon.

E Select the software you want to uninstall such as your product’s driver and the application from the list
displayed.

F Do one of the following.

Windows 8 and 7: Select Uninstall/Change or Uninstall.

Windows Vista: Click Uninstall/Change or Uninstall, and then click Continue in the User Account Control
window.

Windows XP: Click Change/Remove or Remove.
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Note:
If you chose to uninstall your product’s printer driver in step 5, select the icon for your product and then click
OK.

G When the confirmation window appears, click Yes or Next.

H Follow the on-screen instructions.

In some cases, a message may appear to prompt you to restart your computer. If so, make sure I want to restart my
computer now is selected and click Finish.

For Mac OS X

Note:
❏ To uninstall your software you need to download the Uninstaller.

Access the site at:
http://www.epson.com
Next, select the support section of your local Epson Web site.

❏ To uninstall applications, you must log on to a Computer Administrator account.
You cannot uninstall programs if you log on as a limited account user.

❏ Depending on the application, the Installer may be separated from the Uninstaller.

A Quit all running applications.

B Double-click the Uninstaller icon in your Mac OS X hard drive.

C Select the check boxes for the software you want to uninstall, such as the printer driver and the application, from
the list displayed.

D Click Uninstall.

E Follow the on-screen instructions.

If you cannot find the software you want to uninstall in the Uninstaller window, double-click the Applications folder
in your Mac OS X hard drive, select the application you want to uninstall, and then drag it to the Trash icon.

Note:
If you uninstall the printer driver and the name of your product remains in the Print & Scan (for Mac OS X 10.8 or 10.7) or
Print & Fax (for Mac OS X 10.6 or 10.5) window, select the name of your product and click the - remove button.
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Transferring Data Using an External Storage
Device

Note:
The availability of this feature varies by product.

You can use the product’s memory card slot to copy files to a computer connected to the product. You can also use it to
copy files on your computer to the storage device.

Precautions on Storage Devices

Keep the following in mind when copying files between your storage device and computer:

❏ Check the documentation that came with your storage device and any adapter you may be using for any handling
guidelines.

❏ Do not copy files to a storage device while you are printing from your storage device.

❏ The product display does not update information about your storage device after you copy files to it or delete files
from it. To update the information displayed, eject and reload the storage device.

❏ Do not eject your memory card or turn off the product while the memory card light is flashing or you may lose
data.

Copying Files Between a Storage Device and Your
Computer

Copying files to your computer

A Make sure the product is turned on and a storage device is connected.

B Windows 8: 
Select All apps and then select Computer.

Windows 7 and Vista: 
Click the start button and select Computer.

Windows XP: 
Click Start and select My Computer.

Mac OS X: 
The removable disk icon ( ) appears on your desktop automatically.
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C Double-click the removable disk icon, then select the folder in which your files are saved.

Note:
If you have set a volume label, it is displayed as the drive name. If you have not set the volume label, “removable disk”
is displayed as the drive name on Windows XP.

D Select the files you want to copy and drag them to a folder on your computer’s hard drive.

c Important:
For Mac OS X users
When you remove the storage device, always drag the removable disk icon on your desktop into the trash before
you remove the storage device or you may lose data on the device.

Saving files to a storage device

Note:
If USB is selected from the File Sharing Setup menu, you cannot write to the memory card from a computer connected
through a network. To give write access to the network computer, change the setting to Wi-Fi.
& “Setup Mode” on page 78

A Make sure the product is turned on and a storage device is connected.

B Windows 8: 
Select All apps and then select Computer.

Windows 7 and Vista: 
Click the start button and select Computer.

Windows XP: 
Click Start and select My Computer.

Mac OS X: 
The removable disk icon ( ) appears on your desktop automatically.

C Double-click the removable disk icon, then select the folder in which you want to save your files.

Note:
If you have set a volume label, it is displayed as the drive name. If you have not set the volume label, “removable disk”
is displayed as the drive name on Windows XP.

D Select the folder on your computer’s hard drive that contains the files you want to copy. Then select the files and
drag them to the folder on your storage device.

c Important:
For Mac OS X users
When you remove the storage device, always drag the removable disk icon on your desktop into the trash before
you remove the storage device or you may lose data on it.
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Error Indicators

Error Messages on the Control Panel (XP-310 Series/
XP-410 Series)

This section describes the meaning of messages displayed on the LCD screen.

XP-410 Series

Error Messages Solutions

Paper jam. & “Paper Jams” on page 122

Paper out. Load paper. Load some paper. Otherwise, make sure the number of sheets
does not exceed the limit specified for the type of media you are
using.

Printer error. Turn power off and on again. Turn the product off and then back on. Make sure that no paper is
still in the product. If the error message still appears, contact Epson
support.

Communication error. Connect computer. Make sure the computer is connected correctly. If the error
messages still appears, make sure that scanning software is
installed on your computer and that the software settings are
correct.

A printer’s ink pad is nearing the end of its service life.
Please contact Epson Support.

Press x button to resume printing. The message will be displayed
until the ink pad is replaced. Contact Epson support to replace ink
pads before the end of their service life. When the ink pads are
saturated, the product stops and Epson support is required to
continue printing.

A printer’s ink pad is at the end of its service life. Please
contact Epson Support.

Contact Epson support to replace ink pads.

Operation canceled. No memory card recognized. Make sure the memory card has been inserted correctly. If it is
inserted correctly, check to see if there is a problem with the card
and try again.

Combination of IP address and subnet mask is invalid. See
documentation.

Refer the online Network Guide.

Recovery Mode The firmware update has failed. You will need to re-attempt the
firmware update. Ready a USB cable and visit your local Epson
website for further instructions.

XP-310 Series

Code* Error Messages Solutions

E-01 Printer error. Turn the printer off and then back on. Make sure that no paper is
still in the printer. If the error still appears, contact Epson support.

E-02 Scanner error. Turn the printer off and then back on. If the error message still
appears, contact Epson support.
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Code* Error Messages Solutions

E-10 An ink pad needs service. Contact Epson. Turn off the printer. Contact Epson support to replace ink pads.

W-02 Paper jam. Remove jammed paper. Remove the jammed paper, turn off the printer, and then turn it
back on.
& “Paper Jams” on page 122

W-03 Paper jam. Remove jammed paper. Open the scanner unit, remove the jammed paper, and then press
x.
& “Paper Jams” on page 122

W-10 Ink cartridges are installed incorrectly. The ink cartridge(s) shown on the LCD panel have not been
installed. Install them.

W-12 Ink cartridges is not recognized. Please
replace cartridges.

Cannot recognize the ink cartridge(s) shown on the LCD panel.
Replace the ink cartridge(s). Epson recommends the use of
genuine Epson ink cartridges.

W-13 An ink pad is nearing the end of service
life.

Press x to resume printing. The message will be displayed until
the ink pad is replaced. Contact Epson support to replace ink pads
before the end of their service life. When the ink pads are
saturated, the printer stops and Epson support is required to
continue printing.

I-22 Press the push button of router. To establish a wireless connection using an access point, press the
push button on the access point or click the button on the access
point’s wireless settings screen displayed on your computer’s
screen. Refer the online Network Guide.

I-23 Enter PIN to access point. You need to enter the PIN code displayed on the printer’s panel
into the access point or computer within two minutes. If no code is
entered during the two minutes, a time-out error occurs and a
different code is displayed and needs to be entered.

I-31 Install the software on the PC from the CD.
Start Wi-Fi setup.

To make wireless connection settings from your computer, you
need to insert the CD into the computer and follow the on-screen
instructions.

I-60 No computer found. Your computer may not support WSD (Web Services for Devices).
The scan to PC (WSD) function is only available for computers
running English versions of Windows 8, 7 or Vista.

- Recovery Mode The firmware update has failed. You will need to re-attempt the
firmware update. Ready a USB cable and visit your local Epson
website for further instructions.

* The code will appear on the top right on the screen.

Error Indications on the Control Panel (XP-210 Series)

You can identify many common product problems using the lights on your product. If the product stops working and
the lights are on or flashing, use the following table to diagnose the problem, then follow the recommended corrective
measures.
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Lights Problem and solution

Paper out

No paper is loaded. Load paper into the sheet feeder, and then press one
of the start x buttons. The product resumes printing
and the light goes out.

Multiple-paper feed

More than one sheet has been fed at a time. Load paper in the sheet feeder correctly and press one
of the start x buttons. If the paper remains in the
product, see “Paper Jams” on page 122.

Paper jam

Paper has jammed in the product. & “Paper Jams” on page 122

Ink expended

An ink cartridge is expended or not installed, or
there is insufficient ink in the cartridge to charge
the ink.

Replace the ink cartridge for which an error is
indicated with a new one. If the light is still on after you
have replaced the cartridge, it may not be installed
correctly. Reinstall the ink cartridge so that it clicks
into place.
& “Replacing an Ink Cartridge” on page 89

Wrong cartridge

The currently installed ink cartridge cannot be
used with the product.
You cannot use the cartridges that came with
your product for the replacement.

Replace the incompatible cartridge for which an error
is indicated with an appropriate ink cartridge.
& “Replacing an Ink Cartridge” on page 89

Incorrectly installed ink cartridge

An ink cartridge is not installed correctly. Reinsert the ink cartridge for which an error is
indicated.
& “An ink error is indicated after you replace the
cartridge” on page 133

Ink low

An ink cartridge is nearly expended. Obtain a replacement ink cartridge. To determine
which cartridge is nearly expended, check the ink
cartridge status.
& “Checking the Ink Cartridge Status” on page 83

Flashing
alternately

Maintenance

The product’s ink pads are nearing or at the end of
their service life.

Contact Epson support to replace ink pads.
If the product’s ink pads are nearing the end of their
service life, printing can be resumed by pressing one
of the start x buttons.
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Lights Problem and solution

Fatal error

An unknown product error has occurred. Turn off the product. Then, remove the jammed
paper.

& “Paper Jams” on page 122 
Then turn the product back on. If the error does not
clear, contact your dealer.

Wi-Fi network error

An error occurred while establishing the Wi-Fi
connection.

Press the Wi-Fi button to clear the error and try again.
For more details, see the online Network Guide.

Recovery mode

The firmware update has failed, and the product
is in recovery mode.

You will need to re-attempt the firmware update.
Ready a USB cable and visit your local Epson website
for further instructions.

 = on,  = flashing slowly,  = flashing fast
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Troubleshooting for Printing/Copying

Diagnosing the Problem

Troubleshooting product problems is best handled in two steps: first diagnose the problem, then apply likely solutions
until the problem is fixed.

The information that you need to diagnose and solve most common problems is provided by online problem solving,
the control panel, or the status monitor. Refer to the appropriate section below.

If you have a specific problem relating to print quality, a printing problem not related to print quality, or a paper
feeding problem, or if the product does not print at all, refer to the appropriate section.

To solve a problem, you may need to cancel printing.
& “Canceling Printing” on page 41
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Checking product status

If a problem occurs while printing, an error message will appear in the status monitor window.

If an error message appears indicating the product’s ink pads are nearing the end of their service life, contact Epson
support to replace them. The message will be displayed at regular intervals until the ink pads are replaced. When the
product’s ink pads are saturated, the product stops and Epson support is required to continue printing.

For Windows

Note:
The order in which ink cartridges are listed varies depending on the printer.

There are two ways to access EPSON Status Monitor 3:

❏ Double-click the product shortcut icon on your Windows taskbar. To add a shortcut icon to the taskbar, see the
following section:
& “From the shortcut icon on the taskbar” on page 37

❏ Open the printer driver, click the Maintenance tab, then click the EPSON Status Monitor 3 button.

When you access EPSON Status Monitor 3, the following window appears:

Note:
If EPSON Status Monitor 3 does not appear, access the printer driver and click the Maintenance tab and then the Extended
Settings button. In the Extended Settings window, check the Enable EPSON Status Monitor 3 check box.

EPSON Status Monitor 3 provides the following information:
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❏ Current Status: 
If the ink is low or expended, the How to button appears in the EPSON Status Monitor 3 window. Clicking How to
displays ink cartridge replacement instructions and moves the ink cartridge holder to the ink cartridge
replacement position.

❏ Ink Levels: 
EPSON Status Monitor 3 provides a graphic display of the ink cartridge status.

❏ Information: 
You can view information about the installed ink cartridges by clicking Information.

❏ Technical Support: 
Click Technical Support to access the Epson technical support website.

❏ Print Queue: 
You can view Windows Spooler by clicking Print Queue.

For Mac OS X

Note:
The order in which ink cartridges are listed varies depending on the printer.

Follow these steps to access EPSON Status Monitor.

A Access the Epson Printer Utility 4.
& “Accessing the printer driver for Mac OS X” on page 37
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B Click the EPSON Status Monitor icon. The EPSON Status Monitor appears.

You can also use this utility to check the ink cartridge status before printing. EPSON Status Monitor displays the
ink cartridge status at the time it was opened. To update the ink cartridge status, click Update.
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When ink is low or expended, a How to button appears. Click How to, and EPSON Status Monitor will lead you step by
step through the ink cartridge replacement procedure.

Paper Jams

!Caution:
Never touch the buttons on the control panel while your hand is inside the product.

Note:
❏ The illustrations in this section may vary depending on the product.

❏ Cancel the print job if prompted by a message from the LCD screen or the printer driver.

Removing jammed paper from inside the product

Note:
The illustrations in this section may vary depending on the product.

A Cancel the print job if prompted by a message from the printer driver.

& “Canceling Printing” on page 41
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B Open the scanner unit.

Note:
Some products may come with a scanner unit support.
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C Remove all of the paper inside, including any torn pieces.

D Close the scanner unit. If the jammed paper remains near the output tray, carefully remove the paper.
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Note:
If the printer is equipped with a scanner unit support, close the scanner unit as shown below.

E Press the button indicated in the LCD screen.

For the products without LCD screens: If all the lights on the control panel flash, press the P button to turn the
printer off and then on again. If only the P and b lights flash, press x r or r x button.

Preventing paper jams

If your paper jams frequently, check the following.

❏ The paper is smooth, not curled or wrinkled.

❏ You are using high-quality paper.

❏ The printable side of the paper is face up in the sheet feeder.

❏ The paper stack was fanned before loading.

❏ For plain paper, do not load paper above the line just under the H arrow mark inside the edge guide.
For Epson special media, make sure the number of sheets is less than the limit specified for the media.
& “Selecting Paper” on page 20

❏ The edge guides are snug against the edges of the paper.

❏ The product is on a flat, stable surface that extends beyond the base in all directions. The product will not operate
properly if it is tilted.

Reprinting after a paper jam (for Windows only)

After you cancel the print job because of a paper jam, you can reprint it without reprinting pages that have already been
printed.

A Solve the paper jam.
& “Paper Jams” on page 122
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B Access the printer settings.
& “Accessing the printer driver for Windows” on page 36

C Select the Print Preview check box in the Main or Advanced window of your printer driver.

D Make the settings that you want to use to print.

E Click OK to close the printer settings window, and then print your file. Print Preview window opens.

F Select a page that has already been printed in the page list box on the left side, and then select Remove Page from
the Print Options menu. Repeat this step for all the pages that have already been printed.

G Click Print on the Print Preview window.

Print Quality Help

If you are having print quality problems, then compare it with the illustrations below. Click the caption under the
illustration that best resembles your prints.

Good sample Good sample

& “Horizontal banding” on page 127 & “Vertical banding or misalignment” on
page 127

& “Horizontal banding” on page 127 & “Vertical banding or misalignment” on
page 127
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& “Incorrect or missing colors” on page 128 & “Blurry or smeared print” on page 128

Horizontal banding

❏ Make sure the printable side (the whiter or glossier side) of the paper is face up in the sheet feeder.

❏ Run the Head Cleaning utility to clear any clogged ink nozzles.
& “Cleaning the Print Head” on page 99

❏ For best results, use up ink cartridge within six months of opening the package.

❏ Try to use genuine Epson ink cartridges.

❏ Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in
the product.
& “Selecting Paper” on page 20

❏ If banding appears at intervals of 2.5 cm, run the Print Head Alignment utility.
& “Aligning the Print Head” on page 101

❏ If a moire (cross-hatch) pattern appears on your copy, change the Reduce/Enlarge setting (XP-410 Series only) in
the LCD menu or shift the position of your original.

❏ If there is problem with copy quality, clean the surface of the scanner glass.
& “Cleaning the exterior of the product” on page 105

Vertical banding or misalignment

❏ Make sure the printable side (the whiter or glossier side) of the paper is face up in the sheet feeder.

❏ Run the Head Cleaning utility to clear any clogged ink nozzles.
& “Cleaning the Print Head” on page 99

❏ Run the Print Head Alignment utility.
& “Aligning the Print Head” on page 101

❏ For Windows, clear the High Speed check box from the Advanced window in your printer driver. See the online
help for details.
For Mac OS X, select Off from the High Speed Printing. To display the High Speed Printing, click through the
following menus: System Preferences, Print & Scan (for Mac OS X 10.8 or 10.7) or Print & Fax (for Mac OS X
10.6 or 10.5), your product (in the Printers list box), Options & Supplies, and then Driver.

❏ Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in
the product.
& “Selecting Paper” on page 20
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❏ If there is problem with copy quality, clean the surface of the scanner glass.
& “Cleaning the exterior of the product” on page 105

Incorrect or missing colors

❏ For Windows, clear the Grayscale setting in the Main window in your printer driver.
For Mac OS X, clear the Grayscale setting in Print Settings in the Print dialog box in your printer driver.

❏ Adjust the color settings in your application or in your printer driver settings.
For Windows, check the Color Management settings in the Advanced window.
For Mac OS X, check the Color Options dialog box from the Print dialog box.

❏ Run the Head Cleaning utility to clear any clogged ink nozzles.
& “Cleaning the Print Head” on page 99

❏ If you have just replaced an ink cartridge, make sure the date on the box. If you have not used the product for a long
time, Epson recommends replacing the ink cartridges.
& “Replacing an Ink Cartridge” on page 89

❏ Try to use genuine Epson ink cartridges and paper recommended by Epson.

Blurry or smeared print

❏ Try to use genuine Epson ink cartridges and paper recommended by Epson.

❏ Make sure the product is on a flat, stable surface that extends beyond the base in all directions. The product will not
operate properly if it is tilted.

❏ Make sure your paper is not damaged, dirty, or too old.

❏ Make sure your paper is dry and the printable side (the whiter or glossier side) is face up in the sheet feeder.

❏ If the paper is curled toward the printable side, flatten it or curl it slightly in the opposite direction.

❏ Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in
the product.
& “Selecting Paper” on page 20

❏ Remove each sheet from the output tray as it is printed.

❏ Do not touch or allow anything to come into contact with the printed side of paper with a shiny finish. To handle
your prints, follow the instructions of the paper.

❏ Run the Head Cleaning utility to clear any clogged ink nozzles.
& “Cleaning the Print Head” on page 99

❏ Run the Print Head Alignment utility.
& “Aligning the Print Head” on page 101

❏ If the paper is smeared with ink after printing, clean the interior of the product.
& “Cleaning the interior of the product” on page 106
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❏ If there is problem with copy quality, clean the surface of the scanner glass.
& “Cleaning the exterior of the product” on page 105

Miscellaneous Printout Problems

Incorrect or garbled characters

❏ Clear any stalled print jobs.
& “Canceling Printing” on page 41

❏ Turn off the product and computer. Make sure the product’s interface cable is securely plugged in.

❏ Uninstall the printer driver, then reinstall it.
& “Uninstalling Your Software” on page 110

Incorrect margins

❏ Make sure that the paper is loaded into the sheet feeder correctly.
& “Loading Paper and Envelopes” on page 23

❏ Check the margin settings in your application. Make sure that the margins are within the printable area of the
page.
& “Printable area” on page 144

❏ Make sure the printer driver settings are appropriate for the paper size you are using.
For Windows, check the Main window.
For Mac OS X, check the Page Setup dialog box or Print dialog box.

❏ Uninstall the printer driver, then reinstall it.
& “Uninstalling Your Software” on page 110

Printout has a slight slant

❏ Make sure that the paper is loaded into the sheet feeder correctly.
& “Loading Paper and Envelopes” on page 23

❏ If Fast Economy is selected in Paper & Quality Options in the Advanced tab in your printer driver (for Windows),
or Fast Economy is selected in Print Quality in Print Settings (for Mac OS X), select another setting.

Size or position of copied image is incorrect

❏ Make sure the paper size, layout, or reduce/enlarge setting (XP-410 Series only) selected in the control panel
matches the paper used.

❏ If the edges of the copy are cropped off, move the original slightly away from the corner.

❏ Clean the scanner glass.
& “Cleaning the exterior of the product” on page 105
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Inverted image

❏ For Windows, clear the Mirror Image check box from the Page Layout window of your printer driver, or turn off
the Mirror Image setting in your application.
For Mac OS X, clear the Mirror Image check box in Print Settings in the Print dialog box of your printer driver, or
turn off the Mirror Image setting in your application.

❏ Uninstall the printer driver, then reinstall it.
& “Uninstalling Your Software” on page 110

Blank pages print

❏ Make sure the printer driver settings are appropriate for the paper size you are using.
For Windows, check the Main window.
For Mac OS X, check the Page Setup dialog box or Print dialog box.

❏ For Windows, check the Skip Blank Page setting by clicking the Extended Settings button on the Maintenance
window of the printer driver.
For Mac OS X, select On from the Skip Blank Page. To display the Skip Blank Page, click through the following
menus: System Preferences, Print & Scan (for Mac OS X 10.8 or 10.7) or Print & Fax (for Mac OS X 10.6 or 10.5),
your product (in the Printers list box), Options & Supplies, and then Driver.

❏ Uninstall the printer driver, then reinstall it.
& “Uninstalling Your Software” on page 110

Printed side is smeared or scuffed

❏ If the paper is curled toward the printable side, flatten it or curl it slightly in the opposite direction.

❏ Make several copies without placing a document on the scanner glass.
& “Cleaning the interior of the product” on page 106

❏ Uninstall the printer driver, then reinstall it.
& “Uninstalling Your Software” on page 110

Printing is too slow

❏ Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in
the product.
& “Selecting Paper” on page 20

❏ For Windows, choose a lower Paper & Quality Options in the printer driver Advanced tab.
For Mac OS X, choose a lower Print Quality in the Print Settings dialog box from your printer driver’s Print dialog
box.
& “Accessing the printer driver for Windows” on page 36 
& “Accessing the printer driver for Mac OS X” on page 37

❏ Close any unnecessary applications.
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❏ If you print continuously for an extended period, the printing may be extremely slow. This is to slow down the
printing speed and prevent the product mechanism from overheating and being damaged. If this happens, you
can continue to print, but we recommend stopping and leaving the product idle for at least 30 minutes with the
power on. (The product does not recover with the power off.) After you restart, the product will print at normal
speed.

❏ Uninstall the printer driver, then reinstall it.
& “Uninstalling Your Software” on page 110

If you try all of the methods above and cannot solve the problem, see the following:
& “Increasing the Print Speed (For Windows Only)” on page 134

Paper Does Not Feed Correctly

Paper does not feed

Remove the stack of paper and make sure of the following:

❏ The paper is not curled or creased.

❏ The paper is not too old. See the instructions that came with the paper for more information.

❏ For plain paper, do not load paper above the line just under the H arrow mark inside the edge guide.
For Epson special media, make sure the number of sheets is less than the limit specified for the media.
& “Selecting Paper” on page 20

❏ Paper is not jammed inside the product. If it is, remove the jammed paper.
& “Paper Jams” on page 122

❏ The ink cartridges are not expended. If a cartridge is expended, replace it.
& “Replacing an Ink Cartridge” on page 89

❏ You have followed any special loading instructions that came with your paper.

Multiple pages feed

❏ For plain paper, do not load paper above the line just under the H arrow mark inside the edge guide.
For Epson special media, make sure the number of sheets is less than the limit specified for the media.
& “Selecting Paper” on page 20

❏ Make sure the edge guides are snug against the edges of the paper.

❏ Make sure the paper is not curled or folded. If so, flatten it or curl it slightly toward the opposite side before
loading.

❏ Remove the stack of paper and make sure that the paper is not too thin.
& “Paper” on page 143

❏ Fan the edges of the stack to separate the sheets, then reload the paper.
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❏ If too many copies of a file are being printed, check the Copies setting in your printer driver as follows, and also
check in your application.
For Windows, check the Copies setting on the Page Layout window.
Mac OS X, check the Copies setting in the Print dialog.

Paper is improperly loaded

If you have loaded the paper too far into the product, the product cannot feed the paper correctly. Turn the product off
and gently remove the paper. Then turn the product on and reload the paper correctly.

Paper is not ejected fully or is wrinkled

❏ If the paper does not eject fully, press the x button to eject the paper. For XP-200 Series, press the y button to eject
the paper. If the paper is jammed inside the product, remove it by referring to the following section.
& “Paper Jams” on page 122

❏ If the paper is wrinkled when it comes out, it may be damp or too thin. Load a new stack of paper.

Note:
Store any unused paper in its original packaging in a dry area.

The Product Does Not Print

All lights are off

❏ Press the P button to make sure the product is on.

❏ Make sure that the power cord is securely plugged in.

❏ Make sure that your outlet works and is not controlled by a wall switch or timer.

Only the power light is on

❏ Turn off the product and computer. Make sure the product’s interface cable is securely plugged in.

❏ If you are using the USB interface, make sure your cable meets the USB or Hi-Speed USB standards.

❏ If you are connecting the product to your computer via a USB hub, connect the product to the first-tier hub from
your computer. If the printer driver is still not recognized on your computer, try to directly connect the product to
your computer without the USB hub.

❏ If you are connecting the product to your computer via a USB hub, make sure the USB hub device is recognized by
your computer.

❏ If you are trying to print a large image, your computer may not have enough memory. Try reducing the resolution
of your image or printing the image at a smaller size. You may need to install more memory in your computer.

     User’s Guide

Troubleshooting for Printing/Copying 

132



❏ Users of Windows can clear any stalled print jobs from the Windows Spooler.
& “Canceling Printing” on page 41

❏ Uninstall the printer driver, then reinstall it.
& “Uninstalling Your Software” on page 110

An ink error is indicated after you replace the cartridge

A Open the scanner unit.

B Make sure the ink cartridge holder is at the ink cartridge replacement position.

Note:
For products without LCD screen:
If the ink cartridge holder is at the far right position, press the y button. The ink cartridge holder moves to the ink
cartridge check position. The cartridge that is expended or low is indicated by the  mark on this product. Then
press the y button again. The ink cartridge holder moves to the ink cartridge replacement position.

C Remove and reinsert the ink cartridge and then continue with the ink cartridge installation. Make sure the top
surface of the ink cartridges align.
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D Close the scanner unit slowly and press the button described below.

For products with LCD screen:
Press OK.

For products without LCD screen:
Press y.

Increasing the Print Speed (For Windows Only)

Note:
The screen shots in this section may vary depending on the model.

Print speed may be increased by selecting certain settings in the Extended Settings window when the printing speed is
slow. Click the Extended Settings button on your printer driver’s Maintenance window.
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The following dialog box appears.

Select the following check boxes and print speed may be increased.

❏ High Speed Copies

❏ Always spool RAW datatype

❏ Page Rendering Mode

❏ Print as Bitmap

For more details on each item, see the online help.

Other Problem

Printing plain papers quietly

When plain paper is selected for the paper type or Normal is selected as for quality in the printer driver, the product
prints at high speed. Try choosing Quiet Mode for quieter operation which will reduce the print speed.

For Windows, select the Quiet Mode check box in the Main window of your printer driver.
For Mac OS X, select On from the Quiet Mode. To display the Quiet Mode, click through the following menus: System
Preferences, Print & Scan (for Mac OS X 10.8 or 10.7) or Print & Fax (for Mac OS X 10.6 or 10.5), your product (in the
Printers list box), Options & Supplies, and then Driver.
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Troubleshooting for Scanning

Problems Indicated by Messages on the LCD Screen or
Status Light

❏ Make sure the product is connected to your computer properly.

❏ Turn off the product and turn it on again. If the problem is not solved, the product may be malfunctioning, or the
light source in the scanner unit may need to be replaced. Contact your dealer.

❏ Make sure the scanning software is fully installed.
See the paper manual for instructions on installing the scanning software.

Problems When Starting a Scan

❏ Check the status light and make sure the product is ready to scan.

❏ Make sure your cables are securely connected to the product and a working electrical outlet.
If necessary, test your product’s AC adapter by plugging in another electrical device and turning it on.

❏ Turn off the product and computer, and then check the interface cable connection between them to make sure it is
secure.

❏ Make sure you select the correct product if a scanner list appears when starting to scan.

Windows:
When you start Epson Scan using the EPSON Scan icon, and the Select Scanner list is displayed, make sure you
select the model of your product.

Mac OS X:
When you start Epson Scan from the Applications folder and the Select Scanner list is displayed, make sure you
select the model of your product.

❏ Connect the product directly to the computer’s external USB port or through one USB hub only. The product may
not work properly when connected to the computer through more than one USB hub. If the problem persists, try
connecting the product directly to the computer.

❏ If more than one product is connected to your computer, it may not work. Connect only the product you want to
use, and then try scanning again.

❏ If the scanning software does not work properly, uninstall the software first and then reinstall it as described in the
paper manual.
& “Uninstalling Your Software” on page 110

     User’s Guide

Troubleshooting for Scanning

136



Using the button

Note:
Depending on the product, the scanning function may not be available when using the button.

❏ Check if you have assigned a program to the button.
& “Epson Event Manager” on page 72

❏ Make sure Epson Scan and Epson Event Manager are installed correctly.

❏ If you have clicked the Keep Blocking button in the Windows Security Alert window during or after installation of
the Epson Software, unblock Epson Event Manager.
& “How to unblock Epson Event Manager” on page 137

❏ Mac OS X:
Make sure you are logged on as the user who installed the scanning software. Other users must first start Epson
Scanner Monitor in the Applications folder and then press a button to scan.

How to unblock Epson Event Manager

A Click Start or the start button, and then point to Control Panel.

For Windows 8:
Select Control Panel from Settings.

B Do one of the following.

❏ Windows 8 and 7:
Select System and Security.

❏ Windows Vista:
Select Security.

❏ Windows XP:
Select Security Center.

C Do one of the following.

❏ Windows 8, 7 and Windows Vista:
Select Allow a program/an app through Windows Firewall.

❏ Windows XP:
Select Windows Firewall.

D Do one of the following.

❏ Windows 8 and 7:
Confirm that the check box for EEventManager Application is selected in the Allowed programs/apps
and features list.
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❏ Windows Vista:
Click the Exceptions tab, and then confirm that the check box for EEventManager Application is selected
in the Program or port list.

❏ Windows XP:
Click the Exceptions tab, and then confirm that the check box for EEventManager Application is selected
in the Programs and Services list.

E Click OK.

Using scanning software other than Epson Scan driver

❏ If you are using any TWAIN-compliant programs, such as Adobe Photoshop Elements, make sure that the correct
product is selected as the Scanner or Source setting.

❏ If you cannot scan using any TWAIN-compliant scanning programs, such as Adobe Photoshop Elements,
uninstall the TWAIN-compliant scanning program and then reinstall it.
& “Uninstalling Your Software” on page 110

Problems When Feeding Paper

The paper gets dirty

You may need to clean the product.
& “Cleaning the Product” on page 105

Multiple sheets of paper are fed

❏ If you load unsupported paper, the product may feed more than one sheet of paper at a time.

❏ You may need to clean the product.
& “Cleaning the Product” on page 105

Problems With Scanning Time

❏ Computers with Hi-Speed external USB ports can scan faster than those with external USB ports. If you are using a
Hi-Speed external USB port with your product, make sure it meets the system requirements.
& “System Requirements” on page 142

❏ Scanning at a high resolution takes a long time.

     User’s Guide

Troubleshooting for Scanning

138



Problems With Scanned Images

Scan quality is unsatisfactory

Scan quality can be improved by changing the current settings or adjusting the scanned image.
& “Image Adjustment Features” on page 53

An image on the back of your original appears in your scanned image

If your original is printed on thin paper, images on the back may be visible to the product and appear in your scanned
image. Try scanning the original with a piece of black paper placed on the back of it. Also make sure the Document
Type and Image Type settings are correct for your original.

Characters are distorted or blurred

❏ In Office Mode or Home Mode, select the Text Enhancement check box.

❏ Adjust the Threshold setting.

Home Mode:
Select Black&White as the Image Type setting, click the Brightness button, and then try adjusting the Threshold
setting.

Office Mode:
Select Black&White as the Image Type setting, and then try adjusting the Threshold setting.

Professional Mode:
Select Black & White as the Image Type setting and click the + (Windows) or r (Mac OS X) button next to Image
Type. Make the appropriate Image Option setting and then try adjusting the Threshold setting.

❏ Increase the resolution setting.

Characters are not recognized correctly when converted into editable text
(OCR)

Place the document so that it is straight on the scanner glass. If the document is skewed, it may not be recognized
correctly.

Ripple patterns appear in your scanned image

A ripple or cross-hatch pattern (known as moiré) may appear in a scanned image of a printed document.

❏ Rotate your original document. Rotate the scanned image using the application software after scanning.
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❏ Select the Descreening check box.

❏ Change a resolution setting and scan again.

Uneven color, smears, dots, or straight lines appear in your image

You may need to clean the interior of the product.

& “Cleaning the Product” on page 105

The scanning area or direction is unsatisfactory

The edges of your original are not scanned

❏ If you are scanning in Full Auto Mode, or using thumbnail preview in Home Mode or Professional Mode, move
the document or photo 6 mm (0.2 inch) away from the horizontal and vertical edges of the scanner glass to avoid
cropping.

❏ If you are scanning using the button or using normal preview in Office Mode, Home Mode, or Professional Mode,
move the document or photo about 3 mm (0.12 inch) away from the horizontal and vertical edges of the scanner
glass to avoid cropping.

Multiple documents are scanned into a single file

Position documents at least 20 mm (0.8 inch) apart from each other on the scanner glass.
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Cannot scan the area you want

Depending on the documents, you may not be able to scan the area you want. Use normal preview in Office Mode,
Home Mode, or Professional Mode and create marquees on the area you want to scan.

Cannot scan in the direction you want

Click Configuration, select the Preview tab, and then clear the Auto Photo Orientation check box. Then, place your
documents correctly.

Problems Remain After Trying All Solutions

If you have tried all the solutions and have not solved the problem, initialize the Epson Scan settings.

Click Configuration, select the Other tab, and then click Reset All.
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Product Information

Ink Cartridges

You can use the following ink cartridges with this product:

Ink Cartridge Part numbers

XP-212
XP-215
XP-312
XP-315
XP-412
XP-415

XP-213
XP-217
XP-313
XP-413

Singapore, HongKong, Taiwan, Korea

XP-312
XP-315
XP-412
XP-415

XP-212

Black 18/18XL 17/17XL 177/178 176/177

Cyan 18/18XL 17/17XL 177 176/177

Magenta 18/18XL 17/17XL 177 176/177

Yellow 18/18XL 17/17XL 177 176/177

Note:
Not all cartridges are available in all regions.

Color Black, Cyan, Magenta, Yellow

Cartridge life For best results, use up ink cartridge within six months of opening the package.

Temperature Storage:
-20 to 40 ˚C (-4 to 104 ˚F)

1 month at 40 ˚C (104 ˚F)

Freezing:*
-12 ˚C (10.4 ˚F)

* Ink thaws and is usable after approximately 3 hours at 25 ˚C (77 ˚F).

System Requirements

For Windows

System PC Interface

Windows 8 (32-bit, 64-bit), Windows 7 (32-bit, 64-bit), Vista (32-bit, 64-bit), XP SP1
or higher(32-bit), or XP Professional x64 Edition

Hi-Speed USB
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For Mac OS X

System PC Interface

Mac OS X 10.5.8, 10.6.x, 10.7.x, 10.8.x Hi-Speed USB

Note:
The UNIX File System (UFS) for Mac OS X is not supported.

Technical Specifications

Note:
Specifications are subject to change without notice.

Printer specifications

Paper path Sheet feeder, top entry

Capacity XP-310 Series/XP-410 Series: 11 mm (0.4in) *1*2

XP-210 Series: 6 mm (0.2in) *1*2

*1 For Legal and User Defined sizes, load one sheet at a time.

*2 Paper with a weight of 64 to 90 g/m2(17 to 24 lb).

Paper

Note:
❏ Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time,

Epson cannot attest to the quality of any non-Epson brand or type of paper. Always test samples of paper stock
before purchasing large quantities or printing large jobs.

❏ Poor quality paper may reduce print quality and cause paper jams or other problems. If you encounter
problems, switch to a higher grade of paper.

Single sheets:
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Size A4 210 × 297 mm

10 × 15 cm (4 × 6 in.)

13 × 18 cm (5 × 7 in.)

A6 105 × 148 mm

A5 148 × 210 mm

B5 182 × 257 mm

9 × 13 cm (3.5 × 5 in.)

13 × 20 cm (5 × 8 in.)

20 × 25 cm (8 × 10 in.)

16:9 wide size (102 × 181 mm)

100 × 148 mm

Letter 8 1/2 × 11 in.

Legal 8 1/2 × 14 in.

Paper types Plain paper or special paper distributed by Epson

Thickness
(for plain paper)

0.08 to 0.11 mm (0.003 to 0.004 in.)

Weight
(for plain paper)

64 g/m2 (17 lb) to 90 g/m2 (24 lb)

Envelopes:

Size Envelope #10 4 1/8 × 9 1/2 in.

Envelope DL 110 × 220 mm

Envelope C6 114 × 162 mm

Paper types Plain paper

Weight 75 g/m2 (20 lb) to 90 g/m2 (24 lb)

Printable area

Highlighted portions show printable area.

Single sheets:

Normal Borderless
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Envelopes:

Minimum margin

Media type Single sheets Envelopes

A 3.0 mm (0.12 in.) 3.0 mm (0.12 in.)

B 3.0 mm (0.12 in.) 5.0 mm (0.20 in.)

C 3.0 mm (0.12 in.) 20.0 mm (0.78 in.)

Note:
Depending on the type of paper, print quality may decline in the top and bottom areas of the print, or the area may be
smeared.

Scanner specifications

Scanner type Flatbed color

Photoelectric device CIS
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Effective pixels 10200 × 14040 pixels at 1200 dpi

Scanning area may be restricted if resolution setting is large.

Document size 216 × 297 mm (8.5 × 11.7 inches) A4 or US letter size

Scanning resolution 1200 dpi (main scan)

2400 dpi (sub scan)

Output resolution 50 to 4800, 7200, and 9600 dpi

(50 to 4800 dpi in 1 dpi increments)

Image data 16 bits per pixel per color internal

8 bits per pixel per color external (maximum)

Light source LED

Network interface specification

Wi-Fi Standard: IEEE 802.11b/g/n*1

Security: WEP (64/128bit)
WPA-PSK (TKIP/AES) *2

Frequency Band: 2.4 GHz

Communication Mode: Infrastructure mode,
Ad hoc mode
Wi-Fi Direct*3

*1 Complies with either IEEE 802.11b/g/n or IEEE 802.11b/g depending on location of purchase.

*2 Complies with WPA2 with support for WPA/WPA2 Personal.

*3 XP-210 Series do not support this function.

Memory card

Note:
The availability of this feature varies by product.
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Compatible memory
cards

Memory Stick Duo

Memory Stick PRO Duo

Memory Stick PRO-HG Duo

Memory Stick Micro*

MagicGate Memory Stick Duo

SDXC

SDHC

SD

miniSDHC*

miniSD*

microSDXC*

microSDHC*

microSD*

Media format DCF DCF (Design rule for Camera File system) version 1.0 or 2.0 compliant.

All card types standard version compliant.

Voltage Requirements 3.3 v

* Adapter required.

Photo data specifications

File format JPEG with the Exif Version 2.3 standard

Image size 80 × 80 pixels to 9200 × 9200 pixels

Number of files XP-410 Series: up to 9990
XP-310 Series: up to 2000

Mechanical

XP-210 Series XP-310 Series XP-410 Series

Dimensions Storage

Width: 390 mm (15.4 inches)

Depth: 300 mm (11.8 inches)

Height: 145 mm (5.7 inches)

Printing*1

Width: 390 mm (15.4 inches)

Depth: 504 mm (19.8 inches)

Height: 279 mm (11.0 inches)

Printing*1

Width: 390 mm (15.4 inches)

Depth: 528 mm (20.8 inches)

Height: 279 mm (11.0 inches)

Weight Approx. 3.9 kg (8.6 lb)*2 Approx. 4.2 kg (9.3 lb)*2 Approx. 4.3 kg (9.5 lb)*2

*1 With the output tray extension extended.

*2 Without the ink cartridges and power cord.
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Electrical

XP-210 Series

100-240 V Model

Input voltage range 90 to 264 V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.5 to 0.3 A

Power consumption Standalone copying Approx. 12 W (ISO/IEC24712)

Ready mode Approx. 5.0 W

Sleep mode Approx. 2.7 W

Power off Approx. 0.3 W

XP-310 Series

100-240 V Model

Input voltage range 90 to 264 V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.5 to 0.3 A

Power consumption Standalone copying Approx. 13 W (ISO/IEC24712)

Ready mode Approx. 6.0 W

Sleep mode Approx. 2.7 W

Power off Approx. 0.3 W

XP-410 Series

100-240 V Model

Input voltage range 90 to 264 V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.5 to 0.3 A
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Power consumption Standalone copying Approx. 13 W (ISO/IEC24712)

Ready mode Approx. 6.5 W

Sleep mode Approx. 2.7 W

Power off Approx. 0.3 W

Note:
❏ Check the label on the back of the product for its voltage.

❏ For users in Belgium, power consumption when copying may vary. Check http://www.epson.be for the latest
specifications.

Environmental

Temperature Operation:
10 to 35 ˚C (50 to 95 ˚F)

Storage:
-20 to 40 ˚C (-4 to 104 ˚F)

1 month at 40 ˚C (104 ˚F)

Humidity Operation:*
20 to 80% RH

Storage:*
5 to 85% RH

* Without condensation

Standards and approvals

U.S. model:

Safety UL60950-1
CAN/CSA-C22.2 No.60950-1

EMC FCC Part 15 Subpart B Class B
CAN/CSA-CEI/IEC CISPR 22 Class B

These equipments contains the following wireless module.
Manufacture: Askey Computer Corporation
Type: WLU6117-D69 (RoHS)

This product conforms to Part 15 of the FCC Rules and RSS-210 of the IC Rules. Epson cannot accept responsibility for
any failure to satisfy the protection requirements resulting from a non-recommended modification of the product.
Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this
device must accept any interference received, including interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from
windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to
licensing.
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European model:

Low voltage directive 2006/95/
EC

EN60950-1

EMC directive 2004/108/EC EN55022 Class B
EN61000-3-2
EN61000-3-3
EN55024

R&TTE directive 1999/5/EC EN300 328
EN301 489-1
EN301 489-17
EN60950-1

For European users:
We, Seiko Epson Corporation, hereby declare that the equipment Models, C462K, C462L and C462M are in
compliance with the essential requirements and other relevant provisions of Directive 1999/5/EC.

For use only in Ireland, UK, Austria, Germany, Liechtenstein, Switzerland, France, Belgium, Luxemburg,
Netherlands, Italy, Portugal, Spain, Denmark, Finland, Norway, Sweden, Iceland, Cyprus, Greece, Slovenia, Malta,
Bulgaria, Czech, Estonia, Hungary, Latvia, Lithuania, Poland, Romania, and Slovakia.

Only indoor operation is permitted in France.
If used outside of own premises, general authorization is required in Italy.

Epson can not accept responsibility for any failure to satisfy the protection requirements resulting a
non-recommended modification of the products.

Australian model:

EMC AS/NZS CISPR22 Class B

Epson hereby declares that the equipment Models, C462K, C462L and C462M are in compliance with the essential
requirements and other relevant provisions of AS/NZS4268. Epson cannot accept responsibility for any failure to
satisfy the protection requirements resulting from a non-recommended modification of the product.

Interface

Hi-Speed USB (Device Class for computers)
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Where To Get Help

Technical Support Web Site

If you need further help, visit the Epson support website shown below. Select your country or region and go to the
support section of your local Epson website. The latest drivers, FAQs, manuals, or other downloadables are also
available from the site.

http://support.epson.net/
http://www.epson.eu/Support (Europe)

If your Epson product is not operating properly and you cannot solve the problem, contact Epson support services for
assistance.

Contacting Epson Support

Before Contacting Epson

If your Epson product is not operating properly and you cannot solve the problem using the troubleshooting
information in your product documentation, contact Epson support services for assistance. If Epson support for your
area is not listed below, contact the dealer where you purchased your product.

Epson support will be able to help you much more quickly if you give them the following information:

❏ Product serial number
(The serial number label is usually on the back of the product.)

❏ Product model

❏ Product software version
(Click About, Version Info, or similar button in the product software.)

❏ Brand and model of your computer

❏ Your computer operating system name and version

❏ Names and versions of the software applications you normally use with your product

Note:
Depending on the product, the dial list data for fax and/or network settings may be stored in the product’s memory. Due to
breakdown or repair of a product, data and/or settings may be lost. Epson shall not be responsible for the loss of any data, for
backing up or recovering data and/or settings even during a warranty period. We recommend that you make your own
backup data or take notes.
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Help for Users in Europe

Check your Pan-European Warranty Document for information on how to contact Epson support.

Help for Users in Taiwan

Contacts for information, support, and services are:

World Wide Web (http://www.epson.com.tw)

Information on product specifications, drivers for download, and products enquiry are available.

Epson HelpDesk (Phone: +0280242008)

Our HelpDesk team can help you with the following over the phone:

❏ Sales enquiries and product information

❏ Product usage questions or problems

❏ Enquiries on repair service and warranty

Repair service center:

Telephone number Fax number Address

02-23416969 02-23417070 No.20, Beiping E. Rd., Zhongzheng Dist., Taipei City 100,
Taiwan

02-27491234 02-27495955 1F., No.16, Sec. 5, Nanjing E. Rd., Songshan Dist., Taipei City
105, Taiwan

02-32340688 02-32345299 No.1, Ln. 359, Sec. 2, Zhongshan Rd., Zhonghe City, Taipei
County 235, Taiwan

039-605007 039-600969 No.342-1, Guangrong Rd., Luodong Township, Yilan County
265, Taiwan

038-312966 038-312977 No.87, Guolian 2nd Rd., Hualien City, Hualien County 970,
Taiwan

03-2810606 03-2810707 No.413, Huannan Rd., Pingzhen City, Taoyuan County 324,
Taiwan

03-5325077 03-5320092 1F., No.9, Ln. 379, Sec. 1, Jingguo Rd., North Dist., Hsinchu City
300, Taiwan

04-23291388 04-23291338 3F., No.510, Yingcai Rd., West Dist., Taichung City 403, Taiwan

04-23805000 04-23806000 No.530, Sec. 4, Henan Rd., Nantun Dist., Taichung City 408,
Taiwan

05-2784222 05-2784555 No.463, Zhongxiao Rd., East Dist., Chiayi City 600, Taiwan

06-2221666 06-2112555 No.141, Gongyuan N. Rd., North Dist., Tainan City 704, Taiwan
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Telephone number Fax number Address

07-5520918 07-5540926 1F., No.337, Minghua Rd., Gushan Dist., Kaohsiung City 804,
Taiwan

07-3222445 07-3218085 No.51, Shandong St., Sanmin Dist., Kaohsiung City 807,
Taiwan

08-7344771 08-7344802 1F., No.113, Shengli Rd., Pingtung City, Pingtung County 900,
Taiwan

Help for Users in Australia

Epson Australia wishes to provide you with a high level of customer service. In addition to your product
documentation, we provide the following sources for obtaining information:

Your Dealer

Don’t forget that your dealer can often help identify and resolve problems. The dealer should always be the first call for
advise on problems; they can often solve problems quickly and easily as well as give advise on the next step to take.

Internet URL http://www.epson.com.au

Access the Epson Australia World Wide Web pages. Worth taking your modem here for the occasional surf! The site
provides a download area for drivers, Epson contact points, new product information and technical support (e-mail).

Epson Helpdesk

Epson Helpdesk is provided as a final backup to make sure our clients have access to advice. Operators on the Helpdesk
can aid you in installing, configuring and operating your Epson product. Our Pre-sales Helpdesk staff can provide
literature on new Epson products and advise where the nearest dealer or service agent is located. Many types of queries
are answered here.

The Helpdesk numbers are:

Phone: 1300 361 054

Fax: (02) 8899 3789

We encourage you to have all the relevant information on hand when you ring. The more information you prepare, the
faster we can help solve the problem. This information includes your Epson product documentation, type of
computer, operating system, application programs, and any information you feel is required.

Help for Users in Singapore

Sources of information, support, and services available from Epson Singapore are:

World Wide Web (http://www.epson.com.sg)

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), Sales Enquiries,
and Technical Support via e-mail are available.
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Epson HelpDesk (Phone: (65) 6586 3111)

Our HelpDesk team can help you with the following over the phone:

❏ Sales enquiries and product information

❏ Product usage questions or problems

❏ Enquiries on repair service and warranty

Help for Users in Hong Kong

To obtain technical support as well as other after-sales services, users are welcome to contact Epson Hong Kong
Limited.

Internet Home Page

Epson Hong Kong has established a local home page in both Chinese and English on the Internet to provide users with
the following information:

❏ Product information

❏ Answers to Frequently Asked Questions (FAQs)

❏ Latest versions of Epson product drivers

Users can access our World Wide Web home page at:

http://www.epson.com.hk

Technical Support Hotline

You can also contact our technical staff at the following telephone and fax numbers:

Phone: (852) 2827-8911

Fax: (852) 2827-4383
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